Getting Started with
FeatureCAM 2004
Engineering Geometry Systems
## Table of Contents

**CHAPTER 1 - INSTALLATION**

- **FEATURECAM PRODUCT LINE** .................................................................................................................. 1
- **INSTALLING THE DONGLE** ........................................................................................................................ 1
- **INSTALLATION PROCEDURES** ....................................................................................................................... 2
- **ENTERING TEMPORARY CODES FOR UPGRADES** .................................................................................... 3
  - Hints on Entering FeatureCAM Registration Codes ......................................................................................... 3
- **REGISTRATION** ............................................................................................................................................. 3
  - Filling Out Registration Forms ........................................................................................................................ 4
  - After Receiving Your Code ................................................................................................................................ 5
- **FEATURECAM MAINTENANCE RELEASES** ................................................................................................. 5
- **EVALUATING PRODUCTS YOU HAVE NOT YET PURCHASED** .................................................................. 5
- **INTERNET WEB SITE** ..................................................................................................................................... 6

**CHAPTER 2 - STEPS FOR CREATING A PART**

- **STARTUP: NEW PART DIALOG BOX** ............................................................................................................ 7
- **STEP 1: STOCK** ............................................................................................................................................... 8
- **STEP 2: GEOMETRY** ........................................................................................................................................ 8
  - Closed Boundary .............................................................................................................................................. 9
  - Open Boundary .............................................................................................................................................. 9
- **STEP 3: CURVES** .......................................................................................................................................... 8
- **STEP 4: FEATURES** ....................................................................................................................................... 9
- **STEP 5: TOOLTIPATHS** ............................................................................................................................... 10
- **STEP 6: NC CODE** ....................................................................................................................................... 12
  - Optimize Feedrates ........................................................................................................................................ 12
  - Display ......................................................................................................................................................... 12
  - Save ............................................................................................................................................................ 12
  - Remap Tooling ........................................................................................................................................... 12
- **CUSTOMIZE MANUFACTURING** ................................................................................................................... 12
  - Tooling ....................................................................................................................................................... 13
  - Material Database ...................................................................................................................................... 13
  - Manufacturing Preferences .......................................................................................................................... 14
  - Configure Post Processor ............................................................................................................................ 14
- **OPTIONAL STEPS** ....................................................................................................................................... 14
  - Surfaces ....................................................................................................................................................... 14
  - Solids ......................................................................................................................................................... 15
  - AFR ............................................................................................................................................................ 15
  - On-line Help .............................................................................................................................................. 15
  - Reference Section ..................................................................................................................................... 16
  - What’s New Section .................................................................................................................................. 16
  - Context Sensitive Help ............................................................................................................................... 16
CHAPTER 3 - INTERFACE TOUR

FEATURECAM INTERFACE COMPONENTS .............................................................................................................17
- Standard Toolbar ..................................................................................................................................................18
- Menu Bar ..........................................................................................................................................................19
- Steps Toolbox ..................................................................................................................................................19
- Graphics Window ...........................................................................................................................................19
- Manufacturing Results Window .....................................................................................................................19
- Geometry Dialog Bar .......................................................................................................................................20
- Assistance Bar ..................................................................................................................................................20
- Status Bar ..........................................................................................................................................................20
- Part View Toolbox ..........................................................................................................................................20

SELECTING GRAPHICAL OBJECTS ....................................................................................................................21

OPTIONAL TOOLBARS ..........................................................................................................................................22
- Advanced Toolbar ............................................................................................................................................22
- Snap Mode Toolbar and Dialog Box ..................................................................................................................23
- Geometry Toolbar ............................................................................................................................................24
- Steps Toolbar ...................................................................................................................................................25

WARPING DIALOG BOXES .....................................................................................................................................25

CUSTOMIZING TOOLBARS .....................................................................................................................................26
- Toolbars Tab ....................................................................................................................................................26
- Commands Tab and Misc. Tab ...............................................................................................................................26

DISPLAY MODE BAR AND SHADING MODE .......................................................................................................27
- Display mode toolbar .........................................................................................................................................28

COLORS .................................................................................................................................................................28

CHAPTER 4 - MAKING YOUR FIRST 2 ½ D PART

Stock Preparation .....................................................................................................................................................29

THE FIRST TIME ..................................................................................................................................................29

CREATE A PART FILE ..........................................................................................................................................29

VIEWING .............................................................................................................................................................31

TOOLPATHS ............................................................................................................................................................32

ORDER OF MANUFACTURING OPERATIONS ......................................................................................................32

PART DOCUMENTATION .....................................................................................................................................33

CONTROLLING THE AUTOMATION ........................................................................................................................34

NC CODE ...............................................................................................................................................................34

TOOL MAPPING ....................................................................................................................................................35

CHANGING POST PROCESSORS ............................................................................................................................35

SAVING NC CODE ...............................................................................................................................................36

SAVING THE FEATUREMILL PART ..........................................................................................................................36

THE NEXT STEP ..................................................................................................................................................36

CHAPTER 5 - FEATURES FROM CURVES ............................................................................................................37

SETTING THE SNAPS ..........................................................................................................................................37

BUILDING CIRCLES ..............................................................................................................................................37
CHAPTER 14 - INTRODUCTION TO FEATUREWIRE

GETTING STARTED ................................................................. 85
CREATING THE PROFILE .................................................. 85
CREATING A WIRE EDM FEATURE ...................................... 86
SIMULATING A WIRE EDM TOOLPATH .............................. 86
Chapter 1
Installation

FeatureCAM Product Line

FeatureCAM products include:

- FeatureMILL2.5D – 2.5D design and toolpath generation for 2 and 3-axis mills.
- FeatureMILL3D – 3D surface modeling and 3-axis toolpath generation
- Solid Modeling – Solid modeling and tools for creating molds from solid models.
- FeatureRECOGNITION – 3D surface and solid import and 2.5D feature recognition.
- FeatureTURN – 2-axis design and toolpath generation for 2-axis lathes.
- FeatureTURN/MILL – Supports lathes with C and Y-axis milling capabilities.
- FeatureWIRE – 2 and 4-axis wire EDM toolpath creation.
- 5-axis Positioning – Manufacture 2.5D features from 5-axis orientations.
- Tombstone – Multiple part manufacturing for horizontal or vertical milling machines with indexers.
- Network – Flexible product licensing allows sharing FeatureCAM licenses across a network.

Installing the Dongle

A dongle is supplied with FeatureCAM for copy protection. The dongle is a physical device about two inches (50 mm) wide that attaches to your computer's parallel printer port. A USB dongle is also available that connects to your computer's USB port. FeatureCAM checks to see if a dongle is present before it generates NC code for your parts or before saving a file. The dongle must remain connected for the entire time you are running FeatureCAM.
Installation

If you downloaded a copy of FeatureCAM over the Internet, or the side of your product box has Evaluation Copy checked, you do not have a dongle. You can draw and simulate designs, but you can’t generate NC code or save or export any files.

If the side of your product box says Upgrade then you purchased an upgrade version of FeatureCAM and you must use the dongle you received with your earlier FeatureCAM purchase.

If you have a dongle, install it on your computer by inserting it in the parallel printer port (or USB port if using a USB dongle) and screwing in the thumbscrews. The dongle is programmed for an initial period (see Registration below). If you have licensed FeatureCAM, then you are given a code to provide unlimited use when you register your copy.

You may have multiple devices attached to your parallel port. Many computers have a printer attached to that port. If you have any devices attached to the port, you will need to chain the devices in sequence and the FeatureCAM dongle should be the first in the stack. Note that you may not connect multiple FeatureCAM dongles to a single parallel port.

The dongle is a pass through device. You can attach your dongle to the computer and the other devices can hook up to the dongle. You may have to experiment with the order of devices a bit to find which sequence works best with your devices. Printers should probably be at the end of the device chain. In general, try to put the dongle in as the first or second device in the sequence.

Installation Procedures

Use the following information to help you install the program and dongle (software key).

For information on installation issues not covered here, refer to the README.WRI and RELNOTES.WRI files on the FeatureCAM Installation CD. These files are also copied to the hard disk in the EZFM directory in a successful installation.

If you’re upgrading an older copy, you can safely overwrite old versions of FeatureCAM. When you are prompted for the installation directory, simply use the same directory you did last time. Your part files and customizations are preserved and can be used with this version of FeatureCAM.

If you wish to continue to run your older copy of FeatureCAM, then install the new version in a different directory. Be aware that your old version may not be able to read files from your new version, but the new version will always be backwards compatible with older versions of files.

The following instructions are written for a CD ROM that is drive D. Substitute the actual drive letter where appropriate.

1. Attach the dongle, if you have one, to your printer port.
2. Put the CD in drive D.
3. If installing from CD, the installation screen should automatically be displayed.
4. If installing from disks or if the installation screen does not automatically come up, choose Run from the Start menu. Type d:\setup if installing from CD.

5. Follow the instructions on the installation screens.

**Entering Temporary Codes for Upgrades**

If you purchased an upgrade to an existing copy of FeatureCAM, your package will contain temporary codes for activating your dongle until you get a chance to register. You must enter these codes to run your new version. If you purchased a new package with a new dongle inside, you do not have to complete these steps.

1. Run FeatureCAM.
2. If the New Part Document Wizard comes up, click *Cancel*.
3. If you have any windows open in FeatureCAM, close them.
4. Select *Evaluation Options* from the *File* menu.
5. Click *Next*.
6. Click *I have an evaluation code* and click *Next*.
7. Enter your evaluation code and click *Finish*.

**Hints on Entering FeatureCAM Registration Codes**

1. Evaluation codes are a collection of the digits 0-9 and the letters A-G.
2. There are no letter Os in the codes, only the number zero.
3. The case of the letters does not matter. Spaces are also ignored.

**Registration**

You must register your new copy of FeatureCAM even if it is an upgrade to an older version.

1. Look at the side of your FeatureCAM box. If *Upgrade* is checked, you purchased an upgrade to your existing copy of FeatureCAM.
2. If FeatureCAM is not already running, run FeatureCAM from the Start menu.
3. If you purchased a new copy of FeatureCAM, the *Registration* dialog box is displayed.
4. If you purchased a new copy of FeatureCAM, the *Registration* dialog box is displayed.
5. If you are updating an existing copy, close all the windows in FeatureCAM (without closing the application itself) and select *Evaluation Options* from the *File* menu.
4. If you did not purchase an upgrade, you will see *Must register* in the *Status* column of the components you purchased. Your dongle will initially work for a limited amount of time. You must register them to remove this limitation.

6. If you did purchase an upgrade, the products that you licensed in previous versions will have *Yes* in the evaluating column. Those components that are already enabled for the version you are installing will have a status of *Fully enabled*. These products will not need to be registered again. Products that are not enabled on your dongle will have *Not licensed* listed in the *Status* column. These are products that you have not purchased.

6. Click *Next*.

**Filling Out Registration Forms**

1. If you want to register using the paper registration form included in the FeatureCAM box, click *Run the program* and click *Finish*. Fill out the form and fax it to the number provided. After receiving a reply follow the instructions under *After Receiving Your Code* listed below.

2. If you want to prepare the registration form on your computer, click *Prepare fax info to receive a code*. You will see the following dialog box.

   ![Registration Form Dialog Box]

   3. Select the products you recently purchased. These products are listed on the side of your FeatureCAM box. If you purchased multiple products, check each product and click *Next*.

4. Fill in the registration forms.

5. On the final screen click *Print*.

6. Fax in the registration.

You should receive your registration code via return fax within 24 hours.
**After Receiving Your Code**

1. Run FeatureCAM.
2. Click *Next* in the *Registration* dialog box.
3. Click *I have registered and have a code*.
4. Select the product(s) that you received codes for. Click *Next*.
5. Enter code(s).
6. Click *OK*.
7. You will see the message *Thank you for registering FeatureCAM.*

Your product is now registered and fully enabled.

**FeatureCAM Maintenance Releases**

If you have purchased and registered a version of a FeatureCAM product, you are allowed to install maintenance releases free of charge. A maintenance release is any product version with the same first number as the product you are licensed to run.

To check to see if a new version of your FeatureCAM product is available:

1. Make sure you are connected to the Internet and select *Check for new version* from the *Help* menu.
2. If a more current version is available you are offered the option of updating your version of the FeatureCAM.

The first time you run your maintenance release the *Registration* dialog box may be displayed. If this happens:

1. Click *Next*.
2. Click *Finish*.

**Evaluating Products You Have Not Yet Purchased**

Once you are running FeatureCAM, you can evaluate other FeatureCAM products.
Installation

1. Run FeatureCAM.
2. If the New Part Document Wizard comes up, click Cancel.
3. Select Evaluation Options from the File menu.
4. Check the Evaluate checkboxes for the product components you want to evaluate.
5. Click OK.

FeatureCAM is now running in evaluation mode. You cannot save parts or post, but you can create part models and generate toolpaths.

The next time you run FeatureCAM, the Registration dialog box is displayed. To run the program normally:

1. Uncheck all the Evaluate checkboxes.
2. Click Next.
3. Select Run the program.
4. Click Finish.

Internet WEB Site

The Internet WEB site [http://www.featurecam.com](http://www.featurecam.com) contains useful information for FeatureCAM users including:

1. New product announcements.
2. A comprehensive database of technical tips.
3. Free maintenance releases.
4. Evaluation copies of new software.
5. Local dealer information.
6. Tradeshows where FeatureCAM is being exhibited.

There is no charge for accessing this WEB site, so feel free to access the latest information on FeatureCAM.
Chapter 2
Steps for Creating a Part

The process for creating parts is laid out sequentially in the Steps toolbox. By using each step, you are guided through the process of creating part programs with FeatureCAM.

**Step 1 - Stock.** The Stock Wizard steps you through entering the shape and dimensions of the stock, the stock material, part program zero and the coordinate system for modeling.

**Step 2 – Geometry.** Points, arcs, lines and other shapes are used to describe the overall shape of parts. Many different geometry tools are available. Geometry can also be imported from CAD systems.

**Step 3 – Curves.** Shapes that involve more than a single line or arc are described as curves. For FeatureMILL3D customers there is also a Surfaces step for creating 3D surfaces.

**Step 4 – Features.** Features are common shop terms like pocket, or thread. They are created from curves and dimensions. These objects describe your part in 3D and are used to generate toolpaths.

**Step 5 – Toolpaths.** Toolpaths are generated from collections of features. You can simulate them in FeatureCAM using toolpath centerlines, 2D shaded or 3D solid shaded simulations.

**Step 6 – NC Code.** Machine-specific G-codes are generated from the toolpaths. Translators are provided for many different NC controls and include a program for creating new translators.

**Customize Manufacturing.** FeatureCAM automates the entire part programming process, you can customize all of the system settings including feed/speed tables, tooling databases or feature settings.
Steps for Creating a Part

**Startup: New Part Dialog Box**

When you start FeatureCAM, the *New Part Dialog Box* is the first thing you see. In this dialog box you can choose to open a new part file, or continue working on an existing file.

**Step1: Stock**

The stock is the initial material from which you will cut your part. It can be rectangular or circular or more general extruded shapes. The stock shape is used for 3D toolpath simulations and to control the extent of milling features like bosses. FeatureCAM has embedded feed/speed tables for many different stock materials, so that feeds and speeds can be automatically calculated based on the stock material. The Stock Wizard provides step-by-step instructions for specifying or modifying the general stock shape, specific stock dimensions, fixture IDs, part program zero, the origin of your modeling coordinate system. To navigate through the wizard, enter the desired information on each page and click the *Next* button to move to the next page.

After completing this step, if you want to create holes, rectangular pockets, slots, circular pockets or thread mill features, you can skip to step 4.

**Step 2: Geometry**

Every part begins with an initial design. You may already have a part drawing, a part sketch or you may want to use FeatureCAM to draw your part design from scratch. The geometry step presents you with methods of creating points, lines, arcs and circles. You can also clip geometry. If you would like to create multiple objects, check the *Create more than one* option at the bottom of the dialog box before selecting the type of object you want to create.

After selecting the type of object you want to create, you are provided instructions in the yellow *Assistance* bar at the bottom of the screen. Type any numeric arguments that are required. Use the TAB key to move to the next field. For point coordinates you can type the individual X, Y and Z coordinates or use the mouse to graphically locate them in the *Graphics* window. As you move the mouse around the Graphics window, you’ll notice that the cursor will snap to discrete locations like circle centers or line endpoints. This location can be controlled by the Snapping dialog, which is discussed in *Chapter 3*.

**Step 3: Curves**

This step groups arcs and lines into curves by automatically tracing smooth paths.
Closed Boundary

This option creates closed curves (curves that form a loop) by clicking on one piece of geometry. An attempt is made to create a closed loop by following smooth paths. If this method does not result in the correct pieces, click the Clear pieces button at the bottom of the screen and select the Curves step again and use the Open boundary command.

Open Boundary

This command creates curves by manually clicking on segments of the curves. To create an open curve (curves that do not form a loop), click on the beginning of the curve and then click on the end. If the resulting curve is not correct, click on a number of intermediate positions to guide the process of creating curves. Closed curves can also be created with this technique by clicking back to the initial piece of geometry.

Step 4: Features

Features are the building blocks for describing your part. For example, if you want a hole in your part, choose the Hole feature. If your part has a pocket, choose the Pocket feature. The Feature wizard walks you through the process of creating features. One category of features are those that can be created solely from dimensions. These features include holes, rectangular-shaped pockets, threads and round pockets (called Step Bores).

Other features require curves to describe their shape. They are listed under the From Curve category. These features include pockets, bosses, grooves, chamfers, rounds, sides and faces.
Steps for Creating a Part

If you want to create a pattern of features, click the *Make a pattern from this feature* checkbox. Click *Next* to step through the wizard.

This wizard steps you through:

- Selecting the feature type
- Optionally entering pattern dimensions
- Positioning the feature
- Specifying the manufacturing strategy
- Reviewing the automatically selected tools
- Reviewing the automatically calculated feeds and speeds
- Overriding the tooling and feed/speed values
- Changing manufacturing attributes

To modify a feature either double-click on a feature or select the feature and click the *Properties* button to open the Properties dialog box for a feature. This dialog box presents all the screens of the New Feature Wizard in a single dialog box. The individual screens are separated into different tabs of the dialog box.

**Step 5: Toolpaths**

This step displays the *Simulation* toolbar. This toolbar has two sections, simulation types and simulation controls. Select the mode of simulation you would like to run from among the simulation types.
Steps for Creating a Part

- **Centerline** simulation displays lines that represent the center of the tool.
- **2D** shows a color simulation from the top view. Each operation is displayed in a different color.
- **3D** shows a 3-dimensional solid shaded simulation.
- **Rapid cut** displays the final result without animating the tool. (FeatureMILL3D only)

Once you select a simulation type, use the simulation controls to control the simulation. Click the Play button to run the simulation. (After pressing the play button, this button turns into the Pause button. Click this button again to pause the simulation.) The Single Step button will display one toolpath move. The Fast Forward to End button, displays all the toolpaths for the part without animating the results. You can then view the toolpaths for each individual operation by clicking the Clear button and then clicking on an operation in the Operation List window.

The Play to Next Operation button will display one complete operation such as a spot drill or a pocket roughing operation. This button is actually a fly-out menu. By clicking on the triangle to the right of the button the following additional options are revealed:

- The Next Rapid button will simulate up to the next rapid move.
- The Next Tool Change button will simulate up to the next tool change.
- Play to Next Zlevel will display the next Z level of a Z level rough or finish operation.

Use the Erase button to erase the centerline toolpaths on the screen. The Region of Interest is used to limit the portion of the part that is simulated for 3D or Rapid Cut simulations. The Show tool load button indicates whether or not to display a graph of the tool load when the next 3D Simulation is performed. The Eject button removes the toolbar and the simulation from the screen. The speed control slider controls how fast simulations run. Move the slider to the right to speed up, or to the left to slow down.

If you see something in the simulation you want to change, you can override any of the tool choices, operation order, or the feeds and speeds if you wish. Continue to simulate and fine-tune the part until you have the settings exactly right.

Center line simulation  
2D simulation  
3D simulation
Step 6: NC Code

You generate NC code in FeatureCAM using this step.

Optimize Feedrates

Use this option to even out the load on the tool by adjusting the feedrate of each NC block.

Display

This option displays the code in the Manufacturing Results window. You can also display the tooling lists and operations sheets by clicking the tabs located at the bottom of the Manufacturing Results window.

Save

The NC code is saved to disk using this command. You also have the option of saving additional documentation like tool lists, operations lists and part databases.

Remap Tooling

This option allows you to change the locations of the selected tools in the tool changer.

Customize Manufacturing

This step allows you to customize the tooling databases, feed/speed databases, and the default system parameters. These options allow you to fine tune FeatureCAM to your preferences.
FeatureCAM supports all the tool types in your shop including drills, taps, reamers, end mills, boring bars, and face mills. Each tool type is described by a series of dimensions.

Tools are grouped into Tool Crib. FeatureCAM provides a comprehensive tooling database and creates a basic tool crib for Inch, or Millimeter tools, or both. FeatureCAM selects tools from the active tool crib to manufacture the part. You can pick the tool crib you want to use for each part or machine. You can also create custom tool cribs with the Tool Manager to reflect the tools owned by your shop or to exactly represent the tools preloaded in your tool changer.

FeatureCAM comes standard with an integrated materials database. Feeds and speeds are stored in tables for each material. Each table contains the settings for different cutting operations. These tables can be customized to change the values or you can add tables for new materials.
Manufacturing preferences, or attributes, control the way a feature is manufactured. FeatureCAM has two different types of attributes, default and feature. Default attributes set the default settings for new features and are accessed by choosing the Customize Mfg. step and then selecting the Establish my manufacturing preferences option. Indicate your preference for settings including climb milling, step over values, canned cycles or ramping and these settings will be used for all parts that you create.

Feature attributes apply to specific features and override the default settings. For example you may set a default setting for climb milling, but override it for bi-directional roughing for a particular feature. To set feature attributes, pick the feature graphically and click the Properties button located at the bottom of the screen.

### Configure Post Processor

This option is available is for customizing post processor settings or selecting a new post processor.

### Optional Steps

**Surfaces**

This step is available in FeatureMILL3D. This step launches the 3D surface wizard which steps you though creating surfaces from curves, primitive surfaces, surfaces from one surface, and surfaces from multiple surfaces.
Steps for Creating a Part

Solids

This step is available in the Solid Modeling option. The Solids step initiates the Solids wizard which helps you create solids using numerous techniques.

AFR

This step is available in the FeatureRECOGNITION option. AFR stands for automatic feature recognition. This step automatically recognizes features from solid models.

On-line Help

FeatureCAM has an extensive on-line help system included with the program. All documentation other than the Getting Started with FeatureCAM guide is on-line. This documentation includes product introductions and reference manuals for all FeatureCAM products.

Select Contents from the Help menu to display on-line help.

Three different tabs are available.

- Contents tab provides an outline view of the help system. Double click on a book or a page to
open it. From a page, click Help Topics to return to the outline view.

- **Index tab** allows you to access the help file using index topics. Type the topic name in the top box and click the Display button.

- **Find tab** provides search capabilities for all pages of the help file. Type the word you would like to find in the top box and then pick a topic in the bottom box. Click Display to view the page.

Help is a point and click interface to on-line information screens that are linked together. A link is any green underlined text or any portion of a diagram that turns the cursor into the pointer cursor. Click on a link to reveal a new screen.

Reference Section

The Reference section of the on-line help contains in-depth technical descriptions of FeatureCAM product features. It is organized in books that address major product topics. For example, the Drawing book contains all the drawing tools contained in FeatureCAM; the Making features book contains a description of features broken down by individual products.

What's New Section

This section keeps you up to date on the latest additions to FeatureCAM.

Context Sensitive Help

While using FeatureCAM you can access the documentation for the current topic by either:

- Pressing F1 for help on your current activity.
- Clicking Help in the dialog boxes.
- Using the tool bar button, ![Help Icon](image), for context sensitive help. Click this button and then click on a menu item, button or dialog box to receive more information.

Written Documentation

Formatted versions of the Getting Started Guide, User Guide and Post Processing manual can be accessed from the Help menu and viewed using Adobe Acrobat. These versions of the documentation are convenient for searching or printing for viewing off-line.
Chapter 3
Interface Tour

FeatureCAM Interface Components

The initial screen provides you with a clean interface for learning FeatureCAM. You can turn on the display of additional toolbars in the View menu under Toolbars. You can also control how much space the Graphics window uses compared to the Manufacturing results window by moving the Sliders from side to side.
Standard Toolbar

A getting started guide can’t describe every button available in the new interface. But every button on a tool bar includes a tool tip. To view the tip, hold the cursor over the button until the tool tip appears. The tool tip describes the function the button activates. Besides the tool tip, the Assistance bar prompts you for the next step in the process. It senses your context and helps you design geometry and features. Refer to the Help system for detailed information.

File functions are controlled in the first group of three buttons, such as creating a new file, opening an existing file, or saving the current file.

Viewing allows you to interactively change the view of the part. Select any of the options from the viewing fly-out. Your cursor shows the same icon as the viewing mode you selected. Viewing is performed interactively in FeatureCAM with the mouse. Rotation, panning and translation are possible. Interactive viewing is disabled while simulating toolpaths or in select or edit modes. See the Fly-out Toolbars section below.

Principal Views changes the view of a part to one of seven standard views. See the Fly-out Toolbars section below.

Shaded allows you to work in shaded mode for solid modeling.

Undo reverses the effect of the previous command. FeatureCAM remembers a long list of the commands that are performed, so you can select Undo multiple times to undo multiple commands.

Delete erases the object that is selected on the screen. The object is removed from the system.

Select puts you in Select mode. You can tell you are in select mode because the mouse appears as a standard arrow pointer in the part window. In select mode, you can click objects to select them.

Transform moves or copies the selected entity according to settings you make in the dialog box.

Context sensitive help accesses on-line help. Click the button, then select the button, field, dialog box or menu item you have questions about.

Options provides access to all the options settings in FeatureCAM.

Help brings up on-line help.
Fly-out Toolbars

A number of buttons in FeatureCAM toolbars are fly-out toolbars. Any button with a small black triangle in the lower right corner is a fly-out toolbar. By clicking on the triangle the menu is revealed. Click again to select a specific option. The last option you picked from the fly-out menu becomes the current command and is displayed as a button in the toolbar. To select this option again, just click on the button in the toolbar.

Menu Bar

The menu bar contains all the menus of the system. These menus contain all the commands available in FeatureCAM.

Steps Toolbox

The Steps toolbox contains an ordered list of steps for creating part programs. Each step is a wizard that presents a series of dialog boxes for each process. They are listed in the order in which you will use them during the process of creating a part program.

Graphics Window

The left-hand window is the graphics window. This window shows the graphical representation of the part and the graphical toolpath simulations.

Manufacturing Results Window

The right-hand window is the Manufacturing Results window. This window contains the
automatically generated documentation including tooling lists, setup sheets and the NC part programs. Selecting one of the tabs at the bottom of the window changes the content of this window.

**Geometry Dialog Bar**

The geometry dialog box is located under the graphics window and manufacturing results window. The point locations and parameters for geometry creation are entered here.

**Assistance Bar**

The Assistance bar displays step-by-step instructions for the current command.

**Status Bar**

The Status bar shows your current drawing units, tool crib, and post processor settings as well as your keyboard status and information about the simulation when you run one.

The Status bar is not a toolbar, nor can it be docked. It is the bottom part of the FeatureCAM window and displays information about the computer, the state of the program, or information about what you are doing. You can toggle it on or off in the View menu under Toolbars.

**Part View Toolbox**

The Part View toolbox provides a hierarchical view of the part. Each setup is listed with each of the feature of the setup listed underneath. From this view you can select, show, hide or modify features. To navigate the part view:

1. If an object has a “+” in its left margin, click it to expand the view to reveal objects that are subordinate. Click on the “-” to collapse the view and hide the subordinate objects. Double clicking on the object also performs the same function.

2. Clicking on an object in the tree view will select the object in the graphics window. This selection method is good for distinguishing between overlapping objects in the graphics window. Make sure you click on the name and not the check box. See item 4 below.

3. Clicking on an object also reveals the button for that feature. Clicking on this button brings up menu of actions you can perform on the object. The actions available are dependent on the object type. Right clicking on the object in the tree view also reveals this menu.
4. Features have a checkbox. If you uncheck the object it will be excluded from the next toolpath generation.

5. By dragging a feature or setup, you can reorder these items.

6. Double-clicking on a feature displays its Properties dialog box for editing.

All objects are represented in the tree view with the exception of geometry.

☐ Part icon represents the entire part. The part file name is also displayed in the tree view.

 NSError Stock icon represents the part stock.

 NSError Setup icon represents a setup. The features of a setup are listed underneath a setup. If you click on a setup, it changes the current setup and current UCS.

 NSError Feature icon represents features. It can be a 2.5D, 3D or turn feature. The checkbox next to the feature can be used to exclude it from toolpath generation. The feature is not deleted; it is just ignored for toolpath generation.

 Curve icon represents a curve in the part model.

 NSError Surface icon represents surfaces. Surface milling features are classified as features, not surfaces.

 NSError Solid icon represents a solid. Individual design features are listed underneath.

### Selecting Graphical Objects

Many commands require you to select object in the Graphics window. To select object you can:

1. Click the left mouse button on an object. This selects that object (by turning it red) and deselects any other object.

2. Hold down the SHIFT key and click the left mouse button on an object. This adds that object to the selected set of objects. This method allows you to select more than one object.

3. Click the left mouse button and drag the mouse before letting up on the button. This method is called box select. As you drag the mouse, a box is displayed in the Graphics window. All objects that are completely enclosed in the box are selected. If you hold down the SHIFT key while selecting, the objects are added to the selected set of objects.

Note: you must be in Select mode (by clicking the Select button) to perform a selection.
Optional Toolbars

While the Steps toolbox and the standard toolbar are all that is necessary to run FeatureCAM, there are additional toolbars that can be displayed by selecting the Toolbars option from the Edit menu.

Advanced Toolbar

Show Fly-out is a fly-out menu for displaying different categories of objects. The categories include geometry, curves, surfaces and features.

Hide Fly-out is a fly-out menu for hiding different categories of objects. This does not delete the objects. They are only removed from the display. These objects can be re-shown using commands in the Show Fly-out.

Curve Wizard provides a centralized interface for curve commands. The commands available in this wizard are also available in the Curves and Surfaces toolbar.

Surface Wizard presents step-by-step instructions for 3D surface construction. The commands available in this wizard are also available in the Curves and Surfaces toolbar.

Solid Wizard presents solid modeling commands available in FeatureMILL3D.

Toggle Geometry Toolbar toggles the display of the Geometry toolbar. This toolbar contains fly-outs for the creation of points, lines, arcs, fillets and dimensions.

Snap Modes displays the Snap Modes dialog. Use this dialog to set the locations for point snapping.

New Feature Wizard steps you through the process of creating part features.

UCS opens the User Coordinate System dialog box for creating or changing existing UCSs.
**Snap Mode Toolbar and Dialog Box**

Entering points by coordinates is exact but not always convenient or feasible. Picking points with the mouse is not always precise enough. The bridge between the methods of point selection is *snaps*. Snapping is a CAD concept that helps you position lines, points or shapes as you construct the geometry of a part. The Snap Mode bar or the Snap Mode Dialog box controls where the cursor snaps. What you have snapped to is displayed in the status bar.

**Grid** displays a grid and enables snapping to the grid. Selecting Snapping Grids from the Options menu controls the spacing of the grid.

**Point** snaps to a point object.

**Endpoint** and **midpoint** snap to the ends and middle points of finite lines and arcs. Endpoint also applies to the corners of the stock.

**Section** snaps equal intervals of a finite line. The number of sections is controlled by the *Sections* parameter of the Snapping Grids dialog box.

**Intersection** snaps to the intersection of lines, arcs and circles.

**Center** snaps to circle centers. This setting also controls the display of circle and arc center points.

**Quadrant** snaps to the four points on a circle corresponding to 0°, 90°, 180° and 270°.

**Tangent** snaps the point so that the object you are creating will be tangent to the object you snapped to.

**Object** snaps to a point on another object. This includes lines of surfaces and is convenient for
snapping points to locations on a surface.

**Snap discrimination dialog** displays a dialog box if the point you select could snap to more than one location.

**Snapping Feedback**

As you snap the cursor changes shape. A small snap icon shadows the cursor around the graphics window. The snap icon jumps to locations near the cursor. It also changes shape in relationship to what it snaps to. When snapping to a circle center, endpoint, midpoint, quadrant or section, the icon is a small box. When snapping tangent to a circle or arc, the icon is a small circle that can slide along the circle or arc while maintaining tangency. Snapping to a grid point, the icon is a small plus sign. When snapping to an object, the icon is a large dot. The following figure shows the cursors and icons of the Graphics window along with the messages displayed in the status bar.

You can have more than one active snap mode at a time. With snaps, it’s easy to create any geometry tangent to circles or arcs, pick the exact center of circles and so on.

**Geometry Toolbar**

The Geometry Toolbar is a series of fly-out toolbars shown below. Note that shop floor versions only have limited geometry creation and no dimension tools are available.
The Steps Toolbox is also available as a toolbar. It is useful to display this toolbar if you want to constantly view the Part View while still having the commands of the Steps Toolbox available. See Chapter 2 for a description of these buttons.

**Warping Dialog Boxes**

During graphical selections, certain dialog boxes will warp out of the way so that the dialog box does not cover the Graphics window. If you click a button like the Pick curve button, the dialog box warps into a single small title bar as shown below.

The cursor changes into a Pick cursor . Select the
object on the screen and the dialog will reappear. To cancel the pick, click on the red “X” in the small title bar. To disable dialog warping, uncheck Warp Dialogs in the Options menu.

**Customizing Toolbars**

The appearance and contents of the toolbars can be customized by selecting Toolbars from the View menu. The Customize toolbars dialog box is displayed.

**Toolbars Tab**

This dialog box has three different purposes.

- **Displaying/hiding toolbars** - Check the checkbox in front a toolbar’s name to display it. Uncheck to hide it.

- **Changing the display of toolbars** - The appearance of the toolbars can be either flat or 3D. The size can be either large or small. Large buttons are recommended for low screen resolutions or touch screens.

- **Creating/deleting toolbars** - The New button will create a new toolbar. The Delete button will delete the toolbar that is selected in the list. You can only delete toolbars that you create. The Reset selected button will return the selected toolbar to its original state. The Default toolbars button will return all the toolbars to their original state and delete any user-defined toolbars.

**Commands Tab and Misc. Tab**

Clicking on the Commands tab puts the interface into a mode that allows you to rearrange the buttons of the interface. You can drag buttons from one toolbar to another or drag a button from a toolbar into the FeatureCAM window to remove it from the toolbar.

By clicking on one of the categories, buttons of that type are displayed. Click on a button to receive a description. You can drag one of these buttons onto any toolbar.

The Misc. tab controls the appearance of the Steps toolbox and the display of the status bar and assistance bars.
Display mode bar and shading mode

By default, everything that you create in FeatureCAM is displayed as a line drawing in the graphics window. Objects can also be viewed as a 2D cross section, 3D shaded or 3D hidden line drawings. See the chart below for the display modes that apply to specific object types and how to activate each type of graphics.

<table>
<thead>
<tr>
<th>Lines</th>
<th>Line drawings apply to points, geometry, dimensions, curves, milling features, turning features, surfaces, solids, stock. It is the default display mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D view</td>
<td>Applies to stock for a turning setup and turning features. This mode is toggled by clicking the 2D turned profiles button in the display mode toolbar.</td>
</tr>
<tr>
<td>Shaded</td>
<td>3D shading applies to milling features, turning features, surfaces, solids. There are a number of ways to shade and unshade objects.</td>
</tr>
<tr>
<td></td>
<td>- Toggle between line drawings and shaded graphics by clicking the Shade button in the Standard toolbar.</td>
</tr>
<tr>
<td></td>
<td>- Shade specific objects on the screen by selecting the object and clicking the Shade selected button in the Display mode toolbar. <strong>This is the only way to shade features.</strong></td>
</tr>
<tr>
<td></td>
<td>- Click the Unshade selected button to return the selected object to lines or click the Unshade all button to return all objects to line drawings. These buttons are in the Display mode toolbar.</td>
</tr>
<tr>
<td>Hidden line</td>
<td>Hidden line graphics only apply to solids so it is best to hide all other objects and display only solids while in this mode. Toggle the Hidden line button in the Display mode toolbar to clip and remove the hidden lines of a solid.</td>
</tr>
</tbody>
</table>

The following figures show a solid displayed as lines, hidden lines and shaded.
Display mode toolbar

The buttons of Display mode toolbar, control the current display mode.

The Display mode toolbar has the following buttons to help you visualize and work with surfaces in the model.

- **Shade selected** shades the selected entities. This gives you a solid like view of the surfaces.
- **Unshade selected** removes shading from the selected entities.
- **Unshade all** unshades everything that is displayed.
- **Hide shaded isoline** is a toggle switch to hide or show the lines of a surface or solid while it is shaded.
- **Hidden line mode** will display all solids as a hidden line drawing. Note that only lines within the solid are hidden. It is best to hide everything and show only the solids to use this mode. Unclick the button to turn off the mode.
- **Show normals** displays the normals for selected surfaces in the model.
- **Unshow normals** hides the normals for selected surfaces in the model.
- **Turning 2D view** toggles the view of a turning stage between 2D or 3D line drawing view.

Colors

Different types of objects have default coloring. For example geometry is black and objects you select turn red. You can change the default color for object types by selecting Coloring from the Options menu and then selecting the object type. The Color menu comes up. Click on the new color and click OK.

You can also change the color of any object, regardless of the object type, by selecting Coloring from the Options menu and then selecting Change selected.
Chapter 4

Making Your First 2 ½ D Part

NOTE: You must have FeatureMILL2.5D to perform this tutorial.

This chapter is a step-by-step tutorial for building a simple part and introducing you to:

- Creating features
- 3D viewing
- Generating toolpaths
- 3D toolpath simulation
- Automatic tool selection, feed/speed calculation
- Dynamically generated setup documentation

Stock Preparation

It is assumed that you have already prepared your stock. If you want to use FeatureCAM for this task, you will want to use the Face feature to face the top of the part and use a Side feature with a line as the profile to square an edge.

The First Time

1. Begin FeatureCAM by selecting FeatureCAM from the Start menu.

   The first time you run FeatureCAM, the tool database is initialized. You’ll be prompted for some information concerning your tool preferences and then the tool information is created based on your answers.

Create a Part File

1. Click New file and click Next
2. Select Milling Setup and click Inch or Millimeter depending on your preference and click Finish.
3. Click the TAB key once to move to the Thickness field. Enter 1.3 (32mm) as the thickness. Accept the default stock dimensions (Width of 4 (100mm) and Length of 5 (120mm)). Click
Making Your First 2 ½ D Part

*Finish.* If someone else has used FeatureMILL, it remembers the stock that was created last, so you may have to reset the values.

For reference, here is a dimensioned drawing of the sample part.

<table>
<thead>
<tr>
<th>English Units</th>
<th>Metric Units</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4. Click the *Features* step from the Steps toolbar.

5. Select *Hole* and click *Next.*

6. Press the TAB key four times to move to the *Diameter* field and enter 0.5 (12mm) and click *Next.*

7. Enter 1.0 (25mm) for the *X* location of the hole center and 1.0 (25mm) for the *Y* location. Click *Next.*

The *Strategy* page is presented. This page provides control over the types of operations that will be used to cut the feature. The default operations for a hole are to spot drill and drill the hole. If the hole had a chamfer, the default would be to cut the chamfer with the spot drill operation.

8. Accept the default strategy settings by clicking *Next.*

The Operations page shows a summary of the operations that will be created to cut the feature. The names of the tools that have been automatically selected and the feeds and speeds are also displayed. Click *Finish* to accept.

9. Create a rectangular pocket feature by clicking the *Features* step from the Steps toolbar.

10. Click *Rectangular Pocket* and click *Next.*

11. Accept the default dimensions by clicking *Next.*

12. Enter 0.75 (15mm) for *X*, 2.5 (60mm) for *Y* and 0 for *Z*. Click *Next.*

13. The *Strategies* page indicates that rough and finish operations will be created. Click *Finish* to accept.
14. Use the Features step to create a second 0.5 (12mm) diameter hole at X=4 (95mm) and Y=3 (75mm).

15. Use the Features step to create another pocket just like the first, except positioned at X=2.5 (55mm), Y=0.5 (15mm).

The sample part is complete. Now use the simulation features to learn about the manufacturing of the part.

**Viewing**

1. So far you have been viewing the part from the top view. Click the Isometric view button from the standard toolbar to get a 3-dimensional view.

2. The Isometric view button is actually a menu. Click on the triangle next to the button. A fly-out menu is displayed. Click Front to display the front view. Click Isometric to return to the isometric view. See Chapter 3 for more information about fly-out menus.
The sample part is complete. Now use the simulation features to learn about the manufacturing of the part.

**Toolpaths**

1. Click the *Toolpaths* step. The *Simulation* toolbar is displayed.

   ![Simulation toolbar diagram]

   This toolbar is described in detail in Chapter 3.

2. Click the *3D* button and click the *Play* button to start the simulation. Click *OK* in the ordering dialog box. These options will be covered later.

3. A solid 3D rendering of the cutting process is displayed.

   ALERT! FeatureMILL runs simulations best in 256 color mode or higher. Depending on your video settings, you might see a warning about this. You may ignore this warning for this tutorial.

4. Click the *Next Operation* button. The spot drill operation is displayed. Click it again and the drill operation is displayed. Click this button until the entire part is cut.

5. Click *Eject*. The Simulation toolbar is removed from the screen.

**Order of Manufacturing Operations**

The order of operations is:
Spotdrill and drill first hole  
Rough and finish first pocket  
Spotdrill and drill second hole  
Rough and finish second pocket

Follow these steps to see how to control the order of manufacturing in FeatureMILL.

1. Click on the Part View tab located below the Steps toolbox. This view shows you a list of all the setups and features you have created. See Chapter 3 for details on the part view.

2. Click rp2, the last name in the list, and drag it up ahead of hl2.

3. Click on the Steps toolbox and click the Toolpaths step Click the 3D button and click the play button. Click OK in the Ordering dialog box. The second pocket is now cut as the third feature.

4. The Op. list tab on the right side of the window shows all of the operations that the features are translated into. Notice on the top of the window the Automatic ordering radio box is checked. This means that automatic rules are being applied to order the operations. Click the Ordering options button.

5. Click Do finish cuts last and click OK.

6. Click the Play button again. You’ll notice in the simulation that the finish cuts for the two pockets now are cut last.

7. Click the Ordering options button again. Uncheck Do finish cuts last and check Minimize tool changes. Click OK.

8. Click the Play button again.

Notice that it now performs all the spot-drills, then the drills, and then the rough and finish milling for each pocket. Notice the cumulative machining time in the status bar. You can also drag and drop individual operations in the Op. list tab if you need to specify an exact ordering of operations.

9. Click the Eject button to erase the simulation and remove the Simulation toolbar.

**Part Documentation**

Not only did the simulation model the manufacturing of the part, it also generated complete tool and operations lists. The tools selected are based on the tool cribs you design so you’re always sure to simulate what you can produce with the tools at hand. The information is already computerized and can be printed for use as an operator’s checklist.

1. Click on the Details tab in the window. The operation sheet looks similar to this:
   
   Op: 1 hole1 (spotdrill)  
   Op: 2 hole1 (drill)  
   Op: 3 rect_pock1 (rough1)
Making Your First 2 1/2 D Part

Op: 4 rect_pock1 (finish)
Op: 5 hole2 (spotdrill)
Op: 6 hole2 (drill)
Op: 7 rect_pock2 (rough1)
Op: 8 rect_pock2 (finish)

You can review this list using the scroll bars, or print it by selecting Print from the File menu. Set the checkboxes for what you want to print and click OK.

2. Click on the Tool List radio button at the top of the Details tab to show the Tooling list. The Tool list contains all of the tools used to create the part based on the crib you have selected. The Tool list looks similar to this:

Crib: basic
Summary:
Slot 1: center_8 D 0.3125 in.
Slot 2: TD_05000_1|2:1 D 0.5000 in.
Slot 3: endmill0437:reg D 0.4375 in

Controlling the Automation

1. Click the Properties button at the bottom of the screen. A dialog box will pop up. Click hole1 and click OK.

2. Click the Strategy tab.

3. Remove the check mark from the Spot Drill check box by clicking until there is no check mark. Click OK.

4. Click the Toolpaths step. Click 3D and click the play button. Notice there is no spot drilling for that hole this time. If you look through the operations list, notice there is now only one spotdrill operation listed. FeatureMILL can optimize the part manufacturing process for you, but you control the level of automatic optimization you want.

5. Click Eject.

NC Code

The purpose of FeatureMILL is to generate NC code to manufacture parts with CNC machines. After you have simulated the part, you can generate NC code. Before you can generate NC code for a part, you have to run a simulation to calculate toolpaths. If you are starting this part of the tutorial without having just run the simulation described above, simulate your part now.
Making Your First 2 ½ D Part

1. Click the NC Code step in the Steps toolbar.

2. Click the button in the dialog box to generate the NC code.

NOTE: If you are running an evaluation copy of FeatureMILL, a dongle, a device that attaches to the computer printer port, is necessary to generate NC code, or save or export files and is not available in the demonstration version. When you purchase FeatureMILL, a dongle is provided to you.

Tool Mapping

1. Click the NC Code step in the Steps toolbar. Click the Re-map the tools button from the dialog box. A dialog box is displayed shows that the tools are in the following order:

<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center_8</td>
<td>1</td>
</tr>
<tr>
<td>TD_05000_1</td>
<td>2:J</td>
</tr>
<tr>
<td>Endmill0375:reg</td>
<td>3</td>
</tr>
</tbody>
</table>

2. In this dialog box you can modify the location of the tools in the tool changer. To move the endmill to the 4th position in the tool changer, click on endmill0375:reg in the table.

3. Change the Tool from a 3 to a 4 at the bottom of the dialog box and click Set.

Note that you cannot change the number directly in the table.

4. Click OK.

Changing Post Processors

1. Follow the remaining steps to change your post processor and save the NC code.

2. From the Manufacturing menu, select Post Process.

3. Click Browse to view the post processors.

   The default directory is c:\Program Files\FeatureCAM\M-libry\Inch for English units. If you need a metric post, browse up one directory level to M-libry. Then browse the Metric directory.

4. Select your processor and click Open. Click OK in the Post Options dialog box. Your processor is now selected and the NC code is automatically updated.

NOTE: Clicking Close will not change your post processor or regenerate the code.
Making Your First 2 1/2 D Part

Saving NC Code

1. Click the NC Code step in the Steps toolbar. Click the Save NC button from the dialog box.

2. Accept the default filename and directory and click OK.

You are ready to machine the part.

Saving the FeatureMILL Part

1. Select the Save button from the Standard toolbar.

2. Select the directory and then type your part name.

The Next Step

You're done with this tutorial and have seen the basic functions of FeatureMILL. The next section expands on this part by building a curve around the features. The curve is created with the layout and drawing tools.
Chapter 5
Features From Curves

NOTE: You must have FeatureMILL to perform this tutorial.

This tutorial builds on the one you just completed and introduces you to:
• Creating geometry (lines, arcs, fillets, etc.)
• Creating irregularly-shaped features
• Contouring around a part and adjusting where the tool plunges

1. Open your sample part from the last chapter or if you skipped the earlier tutorial, open the sample2.fm file or the mtrc_gsg.fm file for metric users. If you installed in the default directory, these files should be in C:\Program Files\FeatureCAM\examples or C:\ezfmsf\examples.

Setting the Snaps
1. Select Snapping Modes from the Options menu.
2. Click the following buttons and turn the others off: Grid points, End points, Intersections, Circle centers, Tangent to objects. If you are running a shop floor version also click Display snap mode dialog…
3. Click OK.

Building Circles
1. The Principal Views button in the Standard toolbar is a fly-out toolbar. Click the triangle next to the button and then click on the Top button in the fly-out toolbar. It is usually easier to draw geometry in this view. (For more information about the fly-out toolbar options, refer to Chapter 3, Interface Tour.)

2. Select the Geometry step from the Steps Toolbox. Click the Create more than one button at the bottom of the dialog box and click the Circle from Rad, Center button.
3. Set R in the dialog bar (below the graphics window) to 0.75 inch (20mm).
4. Click near the center of one hole. The snap jumps to the grid at the hole’s center. If you miss the hole center, click Undo (or select Undo in the Edit menu) and try again.

5. Repeat this action for the other hole. Your part looks similar to the figure below.

![Diagram of a part with circular holes and grid points]

**Drawing Lines**

1. Select the *Geometry* step from the Steps Toolbox. Click the *Create more than one* button at the bottom of the dialog box and click the *Line from 2 pts* button.

2. For point 1 in the diagram below, click the top of the right circle. If you are running the shop floor version the following snap selection dialog box appears. Select *Tangent to circle* and click *OK*.

![Snap Discrimination Dialog](image)

3. For the second point click on the upper left grid point, point 2, as shown with Xs above.

4. Continue building lines from point 2 to point 3, from point 4 to point 5, and from point 5 to point 6. The completed lines look like this:

![Completed lines](image)
5. Select the *Geometry* step from the Steps Toolbox. Click the *Create more than one* button at the bottom of the dialog box and click the *Fillet* button.

6. Set $R$ in the dialog bar to 0.75 inch (20mm)

7. Click the point marked near the upper left corner. The diagram below shows where to click to create the fillets. A corner fillet appears automatically trimming the lines to fit.

8. Click the point marked near the lower right corner. A corner fillet appears automatically trimming the lines to fit.

**Chaining a Curve**

1. Select the *Curves* step from the Steps Toolbar.

2. Select *Chain into a closed boundary* and click on the bottom line as shown.

FeatureMILL automatically chains a closed curve and chooses a path without sharp bends so you don’t have to chain all curves manually.

**Feature from a Curve**

1. With the curve still highlighted, click the *Features* step from the Steps toolbox.

2. Select *Side* and click *Next*.

3. The curve you selected is already selected in this dialog box. Click *Next* three times.

4. Set the *Depth* to 1.0 (25 mm).

5. Click *Finish*.
Simulate the Part

You are now ready to simulate your part.

1. Click *Isometric* from the Principal views fly-out.

2. Click the *Toolpaths* step from the Steps toolbar and click the *3D simulation* button and then the play button.

6. Click *OK* in the *Ordering* dialog box and the 3D simulation is displayed in the graphics window.

7. Click the *Eject* button to clear the screen.

Modifying the Side Feature to Contour Around the Part

If you watched the simulation carefully, you saw that the side feature performed both a roughing and finishing operation. To simply contour around the outer boundary of the part, you’ll need to eliminate the roughing operation. The operations that are initially created for a feature are specified on the *Strategies* page of the New Feature wizard, but you can easily modify the strategy for any existing feature.

1. Pick the Side feature and click the *Properties* button at the bottom of the screen.

2. The *Properties* dialog box comes up. This dialog box contains the pages of the *New Feature* wizard as separate tabs.

3. Click on the *Strategy* tab. Notice that the *Rough* and *Finish* checkboxes are checked. Uncheck the *Rough* checkbox, and click *OK*.

4. Simulate the toolpaths again using the *Toolpaths* step.
Changing the Plunge Point

The tool ramped on and off the part at the location that you chained the curve. In this case, the tool is plunging on the stock. To change the plunge point for this operation:

1. Click on the triangle next to the Principal Views button then click on the Top button in the fly-out toolbar.
2. Pick the Side feature and click the Properties button at the bottom of the screen.
3. The left-hand side of the dialog box contains the tree view. It shows the feature with its operations listed underneath. By clicking on an operation in the tree view, you can modify an operation.
4. Click on Finish operation. The tabs of the dialog box change to represent information specific to the operation. Click on the Milling tab. This tab contains the various attributes for changing the toolpaths that are generated for the operation.
5. Click on the Plunge point(s) attribute.
6. Click the Pick XYZ location button that appears at the bottom of the dialog box.
7. Click at a location below the part.
   Note that if you pick a location that is too close to the part, the plunge point is ignored that the toolpaths will remain unchanged.
8. Click OK.
9. Click the Toolpaths step, click the centerline simulation button and the play button to view the changes in the toolpath.

The Next Step

You have completed this tutorial. In the next tutorial you will learn how to create patterns and customize the manufacturing of your parts.
NOTE: You must have FeatureMILL to perform this tutorial.

This tutorial explains the following concepts:

• Creating patterns of features
• Changing attributes to alter the way a feature is manufactured.
• Manually selecting tooling

This tutorial assumes you have already performed the earlier milling tutorials.

Creating Patterns

1. Click the New button from the Standard toolbar. Select Milling Setup and Click Inch or Millimeter depending on your preference and click OK.

2. In the Dimensions dialog box, set Width to 4 (100mm), Length to 4 (100mm), and Thickness to 1 (25mm). Click Finish.

3. Click the Feature step from the Steps Toolbar.

4. Click Hole and check Make a pattern from this feature and click Next.

5. Under Type of hole, select Tapped hole from the drop-down list.

6. Set the Chamfer to 0.0 (0mm), Set the Thread Depth to 0.5 (13mm), Depth to 1.0 (25mm).

7. If working in millimeters, click Metric and set the Pitch to 1.

8. If working in inches, set the TPI to 20.

9. Check the Through checkbox and set the Diameter to 0.25 (6mm).

10. Click Next.

11. Click Radial as the pattern type and click Next.
Patterns and Modification

12. In the Pattern - Dimensions dialog box set Number to 8, Diameter to 1.5 (38mm), Spacing to 45, Angle to 0 (0mm) and click Next.

13. Set X to 2(50mm), Y to 2(50mm), Z to 0.
14. Click Next twice.
15. Note the tools that have been selected including the center_5 center drill. Accept these choices by clicking Finish.

Simulating Toolpaths

1. The Principal Views button in the Standard toolbar is a fly-out toolbar. Click the triangle next to the button and then click on the Front button in the fly-out toolbar. (For more information about the fly-out toolbar options, refer to Chapter 3, Interface Tour.)

2. Click the Toolpaths step. Click Centerline and click the play button.
3. In the Ordering dialog box, click the Milling Ordering button. Make sure that Minimize rapids and Minimize tool changes are both checked. Click OK and OK again to simulate. Notice that the tool retracts to a high plane.
4. Click the NC Code tab. Notice that the code is very inefficient. The machine enters canned cycle mode, performs one operation, and then exits canned cycle mode for every operation.
5. Click the Eject button.
Modifying How the Pattern is Manufactured

1. Click on the Part View toolbox. It is located at the top of the Steps toolbox.

   For more information on the Part View toolbox see Chapter 3.

2. Click on pattern1. Click on the triangle located to the right to reveal the pop-up menu. Click Properties.

   The Properties dialog box combines all of the dialog boxes you used to create the features using the New feature wizard. Each of the wizard dialog boxes is contained as a tab of the Properties dialog box. The left-hand side of the Properties box shows a tree-view, which is a portion of the Part View that applies to this feature. Clicking on the different features and operations in the tree view changes the tabs of the dialog box.

3. Click on the hole1 feature in the tree view. Click on the Strategy tab. Click on the Combine with similar holes check box. This will lower the retract plane for the pattern and improve the efficiency of the NC code. Click OK.

4. Click on the Steps toolbox to display the steps. Click the Toolpaths step and click the play button. Click OK in the Ordering dialog box. Notice that the tool retracts to a lower plane. Click the Eject button.

5. Click the NC Code tab. Notice that the code is more efficient. The machine enters canned cycle mode, performs all the operations, and then exits canned cycle.
FeatureCAM makes the conservative assumption of retracting to the retract plane between operations. If you are certain that no collisions will occur, you can set the Retract to plunge clearance attribute on the features to obtain more efficient code.

**Creating Another Hole and Specifying Tools**

1. Click the Features step from the steps toolbar to create a plain hole with Depth of 1.0 (25mm) and a Diameter of 0.5 (13mm).

2. On the Location page set X to 0.75 (19mm) and Y to 0.75 (19mm) and click Next.

3. Click Next on the Strategies page.

4. On the Operations page it shows that a number 5-center drill is selected for the spotdrill operation. You will now change it to a number 4-center drill. Click Next.

5. The Default Tool page shows the number 5-center drill. Click the I want to search for another tool… radio button and click Next.

6. Scroll down the list of tools until you see a tool named center45. Check the checkbox on the left of the center_4 tool name to select this tool. Click Next.

7. The Feed Speed page shows the automatically selected feed and speed values. Click Next to accept these values.

8. If you continue to walk through the dialog boxes, the tooling and feeds and speed values for each operation would be presented to you to accept or override. Accept the rest of the values by clicking Finish.

9. Change the view to an isometric view in the Principal Views fly-out.

10. Click on the Steps toolbox to display the steps. Click the Toolpaths button and click the play button. Click OK in the Ordering dialog box. Notice that all the holes are center drilled first with the single tool. (Note: use the slider in the Simulation toolbar to slow the simulation speed if necessary.)

11. Click the Eject button.

12. Click on the Tool List tab. Notice that the only center drill listed is the center_5 tool.

**The Next Step**

You have completed this tutorial.
NOTE: You must have FeatureTURN or FeatureTURN/MILL to perform these tutorials.

If you want to evaluate FeatureTURN:

1. Select FeatureCAM from the Start menu.
2. From the File menu, choose Evaluation Options and make sure Turning is checked.
3. Click OK.

The example is a simple turned part designed to introduce you to several of the drawing and machining tools available in FeatureTURN. The tutorial walks you through creating the part and introduces you to FeatureTURN's automation and ease of use.

The First Time

1. Select FeatureCAM from the Start Menu.

The first time you run FeatureCAM, the material and tool database is initialized. You'll be prompted for some information concerning your tool preferences and then the tool information is created based on your answers.
Create a Part File

1. Click Turning Setup and the Inch radio button and click OK.

2. A Turning setup will default to a round stock. Once in stock properties set the OD to 4 (100mm), Length to 5 (125mm), ID to 0, and.

3. Click on the triangle next to the Finish button and select the Finish and Edit properties and set Z to 0.0625 (1.5mm) and click OK.

4. Select Turning input modes from the Options menu. Make sure that 3D is checked.

5. Select Set tool crib from the Manufacturing menu. Click on the Tools crib and click OK.

6. In the Options menu, set the Turning Input Modes to 3D.

7. Hold your mouse button down on the Viewing button to fly-out the menu and choose Center All to bring your entire drawing into view.

8. Select the Geometry step from the Steps Toolbox. Click the Create more than one button at the bottom of the dialog box and click the Line from 2 pts button. On the bottom of the screen, type in these points to create two lines that define the OD profile: (X=2(50mm), Y=0, Z= -3.5 (-88mm)), (X=1 (25mm), Y=0, Z= -3.5 (-88mm)). Press ENTER. Enter the values (X=1 (25mm), Y=0, Z= -3.5 (-88mm)), (X=1 (25mm), Y=0, Z=0) and press ENTER.

9. Select the Geometry step from the Steps Toolbox and select Chamfer from the list of Fillet commands. Create a chamfer in the corner, setting the width=0.25(6mm) and height=0.25(6mm). Move your mouse close to the chamfer location as shown in the figure below and the chamfer will snap into place. Click your mouse button to place the chamfer on your drawing. Notice how the chamfer automatically trims your lines.
10. Select the **Geometry** step from the Steps Toolbox and click the Line from 2 pts button. Use the following values: \((X=0.625\,(16\text{mm}), \, Y=0, \, Z=0), \,(X=0.625\,(16\text{mm}), \, Y=0, \, Z= -3.75 \,(94\text{mm}))\). Click ENTER.

11. Select the **Curves** step from the Steps Toolbar. Click the **Chain into open boundary** button. Click on the numbered points of each line segment as shown in the figure below. Each line segment will change color when it is selected. Name this curve "Turn" and click ENTER.

12. Select the **Curves** step from the Steps Toolbar. Click the **Chain into open boundary** button. Chain the Bore ID curve by clicking on locations 4 and 5. Label it "Bore", click ENTER. Your drawing should look like the one below.

**Making Features**

The **2D Turned Profiles** button is located on the drawing mode toolbar and will simplify the screen. Annotations have been added below to show the 7 features that make up the part.
1. Click **Feature** step from the Steps Toolbar.

2. Select **Turn** and click **Next**.

3. You will now pick the curve graphically. Click on the Pick Curve button. The dialog box will warp to reveal the Graphics window beneath. Click on the curve you named “Turn” earlier. Since this pick could be either the curve or the line you may see the Select dialog box. This box helps to clarify a pick. In this case, select “Turn” from the list and click **OK** and then click **Next** in the **New Feature – Curve** dialog box.

4. Accept the default strategy settings by clicking **Finish**.

5. Create a Facing Feature by clicking the **Feature** from the Steps Toolbar.

6. Click **Face** and click **Next**.

7. Set **Outer Diameter** to 4 (100mm), **Inner Diameter** to 0, **Thickness** to 0.0625 (1.5mm). Click **OK**. Note that a face feature automatically knows the OD and ID values from the stock properties. Click **Finish** to accept the default values for the rest of the dialog boxes.

8. Click the **Toolpaths** step in the Steps Toolbox. The **Simulation** toolbar is displayed.

9. Click the **3D** button and the **Play** button. Click **OK** in the Ordering dialog if it appears. The following simulation is displayed. Click the **Eject** button to return to the drawing view.

10. Use the **Feature** step from the Steps Toolbar to create a hole. On the **Dimensions** page set the **Diameter** to 1.0 (24mm), **Depth** to 3.75 (94mm) and **Z** to 0 and click **Finish**.

11. Create a bore feature by using the same process you used to create the turn feature. Use the curve you named “Bore”.

50
12. Click on the triangle of the *Principal views* fly-out on the Standard tool bar and click on the *Isometric* button from the fly-out to see an isometric view of your part.

13. Click the *Toolpaths* button in the Steps toolbox and view a 3D simulation by clicking the *3D* button and the *Play* button. Click the *Eject* button to clear the screen.

13. Return to the *Principal Views* fly-out and select *Top* to return to the original view.

14. Use the *Features* step to make a Groove. On the Dimensions page set *Type* to *from dimensions*, *Location* to *ID*, *Orientation* to *X-axis*, *Diameter* to 1.25 (31mm), *Depth* to 0.125 (3mm), *Width* to 0.250 (3mm). Leave the other settings at 0. Click *Next* and set Z to -3 (-75mm). Click *Finish*.

14. Use the *Feature* step to make a Thread. On the Dimension page, check *Get the dimensions from a standard thread*, click *OD* and select the 2.0000-4.5UNC (M50-15 for metric) thread. Click *Next*.

15. On the *Dimensions* page set *Thread* to *Right Hand*, *Thread Length* to 1.0 (24mm). Click *Finish*.

3. Click the *Toolpaths* step in the Steps toolbox and view a 2D simulation by clicking the *2D* button and the *Play* button. Click the *Eject* button to clear the screen.

4. Use the *Features* step to make a Cutoff Feature. On the Dimensions page set *Diameter* to 4 (100mm), *Inner Diameter* to 0, *Width* to 0.125 (3mm). Click *Next* and set Z to -4.5 (-112mm). Click *Finish*.

The sample part is complete. Watch a 2D simulation followed by a 3D simulation to view the finished part.
Ordering of Operations

You can control the ordering of operations by modifying the Turn Operation Template. This template lists the manufacturing order of the various turning features.

1. Click the Ordering option button on the Op. List tab.

2. The Automatic ordering option dialog box comes up. Click on the Use template radio button. Click on Use rules and click the Edit template button.

3. The default order is shown on the left. Click on Rough OD Turn and click the down arrow until it is located under the Finish ID Turn operation. Click on Finish OD TURN and click the down arrow until it is located under Finish ID Turn. Click OK twice.

4. Simulate the toolpaths and you’ll notice that the OD roughing and finishing now happen after the hole is drilled.

Part Documentation

FeatureTURN will automatically generate a Manufacturing Operation sheet and a Tool list. The Manufacturing Operation sheet appears by default in the Results window. It contains information such as machining time, tools selected, feeds and speeds, and horsepower requirements for the various operations. A Tool list is also created that gives all the specification and slot assignments for the tools used to manufacture your part.

1. Click on the Details tab at the bottom of the Results window. Each operation of the process plan is listed in order.

2. Click on the Tool List radio button at the top of the Details tab. Now the tool list is presented in the Results window. This document provides a summary of all the tools required for the job as well as details of each tool.

You can print this documentation by selecting Print from the File menu.
NC Code

After you have simulated the part, you can generate NC code. FeatureTURN comes with many post processors and the ability to create custom post processors as well.

Before you can generate NC code for a part, you have to run a simulation to calculate toolpaths. If you are starting this part of the tutorial without having just run the simulation described above, simulate your part now.

1. Click the NC code step in the Steps toolbar.
2. Click the button in the dialog box to generate the NC code.

NOTE: If you are running an evaluation copy of FeatureTURN, a dongle, a device that attaches to the computer printer port, is necessary to generate NC code, or save or export files and is not available in the demonstration version. When you purchase FeatureTURN, a dongle is provided to you.

Changing Post Processors and Saving NC Code

1. If you are running FeatureTURN, default post processor is for a Bridgeport machine. Follow the remaining steps to change your post processor and save the NC code.
2. From the Manufacturing menu, select Post Process.
3. Click Browse to view the post processors.
4. The default directory is c:\Program Files\FeatureCAM\T-lib\Inch for English units. If you need a metric post, browse up one directory level to M-lib. Then browse the Metric directory.
5. Select your processor and click Open. Click OK in the Post Options dialog box. Your processor is now selected and the NC code is automatically updated.

NOTE: Clicking Close will not change your post processor or regenerate the code.
6. Click the NC code step in the Steps toolbar. Click the Save NC button from the dialog box.
7. Accept the default filename and directory and click OK.

You are ready to machine the part.

Saving the FeatureTURN Part

1. Select the Save button from the Standard toolbar.
2. Select the directory and then type your part name and click OK.
The Next Step

The next tutorial will provide additional information on FeatureTURN.
Chapter 8
Advanced Turning

NOTE: You must have FeatureTURN to perform these tutorials.

This chapter introduces you to:

- Creating a second turning setup
- Creating new tools
- Modifying turning attributes
- Simulating multiple-setup parts

The following part is created in this tutorial.

1. Start by opening the file c:\Program Files\FeatureCAM\examples\turn\turn2.fm or c:\Program Files\FeatureCAM\examples\turn\turn2m.fm if you are working in metric. (This assumes the you installed the program in the default directory. If you installed in another location look in the examples sub-directory.)
Create a New Setup

1. Select Toolbars from the View menu. Click Advanced, and click OK. Click the Setups button from the Advanced toolbar.
2. Click New.
3. Click Next.
4. Click Align to stock face and click Next.
5. Click the button on the left end of the stock picture.
6. Click Finish.
7. Click Close.
8. Select Top from the Principal Views Fly-out menu.

Create a Turn Feature

1. Click Feature step from the Steps Toolbar.
2. If the New Feature – Type dialog box is displayed, select Turning and click Next.
3. Select Turn and click Next.
4. Make sure curve3 is selected in the Curve drop down list and click Finish.
5. Click the Toolpaths step in the Steps Toolbox. The Simulation toolbar is displayed. Click the Centerline button and Play to display the toolpaths.
6. If you look closely at the top of the feature you see a withdraw move as shown below. This move is acceptable, but let's change it to move up and away from the part.

Change Turning Attributes

1. Click on the turn feature in the Graphics window and click the Properties button.
2. Click on the Finish operation in the tree view.
3. Click on the Turning tab.
4. Click on Withdraw angle and type 135 and click Set.
5. Click OK and click Centerline and Play again to see the changed toolpath.
6. The path will now withdraw up and away from the part.

Create a Face Groove

1. Click Feature step from the Steps Toolbar.
2. Select Groove (from dimensions) and click Next.
3. Click Face as the Orientation.
4. Set the Diameter to 1.5 (40mm), the Depth to 0.1 (0.25mm), and the Width to 0.25 (6mm).
5. Set the Location to OD. Click Next.
6. Set Z to 0.0.
7. Click Finish.
8. Click on the Viewing fly-out and click Rotate.
9. Position the mouse in the graphics window and hold down the left mouse button and drag the mouse from right to left. The part will rotate so you can see the groove better.
10. Run a centerline simulation to see the groove toolpaths.

Change Tooling

1. Double-click on the groove feature.
2. Click on the Rough operation in the tree view.
3. The Tools tab is displayed.
4. You will see a “D” next to the tool named SE_BackGrv_125 (SE_Backgrv_3m). (You may need to drag the Name column to the right to see the full name.) This tool is has a 1/8-inch (3mm) width and is the default-selected tool.
Create New Tooling for the Groove

Now cut the groove with a tool that is 0.200 (4mm) wide.

1. Click on the tool SE_BackGrv_125 (SE_Backgrv_3m) tool name.
2. Click the New tool button.
3. Type the name, SE_BackGrv_200 (SE_Backgrv_4m).
4. Change the Width to 0.200 (4mm).
5. Click Preview to see the picture update and click OK.
6. Click Yes when asked to set this tool as the override.
7. Click OK and run a centerline simulation to see the groove cut with the new tool.

Simulating Both Setups

1. Click on the Isometric button.
2. Click the Toolpaths step in the Steps Toolbox to display the Simulation toolbar.
3. Click on the Part View. It is located at the bottom of the Steps toolbox.
4. Click on Setup 1.
5. Click 3D simulation from the Simulation toolbar and click Play.
6. Click on Setup 2 in the Part view.
7. Click Play again.
Subspindle

If your machine has a subspindle, you can create this part in a single program.

Close the Subspindle

1. Click on pt1_turn in the part view.
2. Click Feature step from the Steps Toolbar.
3. Select Subspindle and click Next.
4. Click Subspindle close and check Position subspindle before closing.
5. Click Next and enter –1.0 (-25mm) as the Z coordinate and click Finish.

Open the Main Spindle

1. Click Feature step from the Steps Toolbar.
2. Select Subspindle and click Next.
3. Click Main Spindle Open and click Finish.

Position the Subspindle

1. Click Feature step from the Steps Toolbar.
2. Select Subspindle and click Next.
3. Click Position Subspindle and click Next.
4. Enter 3.0 (75mm) as the Z value and click Finish.

Simulate the Subspindle

1. Double-click on the stock and click on the Indexing tab.
2. Check Generate single program for all setups.
Advanced Turning

3. Click OK.

4. Select Simulation... from the Options menu.

5. Click on the 2D/3D Shaded tab and click Show turned chuck and click OK.

6. Generate a 3D simulation. Notice how the turned chuck changes from one end to the other to simulate the subspindle.

The Next Step

You have completed this tutorial.
NOTE: You must have licensed the Turn/Mill option to run this tutorial.

This tutorial is only available in inch units.

In this tutorial you will learn to:

• Create parts for lathes with milling capabilities
• Mix turning and milling features
• Create milling features on the OD and face of the part
• Accurately simulate a turn/mill part

The following part will be created in this tutorial:

Getting Started

1. Start FeatureCAM.

2. Click New Part Document button.

3. Click on Turn/Mill, click Inch and click OK.
Creating a Turn/Mill Part

4. In the stock dialog enter 3 for the OD, 2 for the Length and 0 for the ID and click Finish. (if this dialog box does not display automatically, click the Stock step from the Steps toolbox).

5. From the Options menu select Turn Input Modes and check Diameter.

Creating a Turned Feature

1. Select the Geometry step from the Steps Toolbox and click the Connected Lines button.

2. On the bottom of the screen, type in these points to create two lines that define the OD profile: (D1=2.5, Z1= 0), (D2=2.5, Z= -1.5). Press ENTER. Type the values (D2=2.75, Z= -1.5). Press ENTER. Type (D2=2.75, Z=-2.0) and press ENTER.

3. Select the Geometry step from the Steps Toolbox and click the Corner fillet button.

4. Enter 0.125 as the radius at the bottom of the screen and click at the location labeled as Corner radius in the figure.

5. Select the Curves step from the Steps Toolbar. Click the Chain into open boundary button. Click on the locations labeled 1 and 2 in the figure. Click ENTER.

6. Select the Features step from the Steps Toolbox.

7. Click Turning and click Next.

8. Click Turn and click Finish.

Creating a Radial Pattern on the Face

1. Select the Features step from the Steps Toolbox.

2. Click Turn/Mill and click Next.

3. Click Hole and Make pattern from this feature and click Next.

4. Enter 1.0 for the Depth, 0.0 for the Chamfer and 0.25 for the Diameter and click Next.
5. Click Radial and click Next.

6. Enter 3.0 for the Number, 2.0 for the Diameter, 120 for the Spacing Angle 60 for the Angle and click Axial for the Feature Orientation and click Finish.

**Engraving on the Face**

1. Select the Curves step from the Steps Toolbar and select the Create curves using curve wizard button.

2. Click Other methods, click Text and click Next.

3. Enter TURNMILL as the Text, click Linear as the Type, Enter –0.0,0.2,0,0 as the X, Y and Z locations. Enter –90 as the Angle. Enter Center as the Justification, Enter 0.4 and 0.4 as the X and Y Scaling and click Finish.

4. Select the text string in the graphics window and click the Features step from the Steps Toolbar.

5. Select Turn/Mill and click Next.

6. Select Groove and click Next three times.

7. On the Dimensions page, enter 0.0625 as the Width, click Simple and Face, and enter 0.02 as the Depth.

8. Click Finish.

**Creating a Pattern of Wrapped Slots**

1. Select the Features step from the Steps Toolbar.

2. Click Turn/Mill and click Next.

3. Click Slot and Make pattern from this feature and click Next.

4. Set Length to 1.0, Width to 0.5, Depth to 0.25 and click Next.

5. Select Radial and click Next.

6. Set Number to 3, Diameter to 2.5, Spacing Angle to 120, Angle to 120 and Feature Orientation to Radial. Click Next.

7. Set Z to 0.25.
8. Click the triangle located in the Finish button and click Finish and Edit Properties. This brings up the properties dialog box for the pattern and allows us to change some additional attributes.

9. Click Wrap feature around Z axis and click OK.

**Simulating a Turn/Mill Part**

1. Click the Toolpaths step in the Steps Toolbox. The Simulation toolbar is displayed.

2. Click the 3D simulation button and click Play. Notice how the toolpaths are accurately simulated including the part rotations.

3. Click Eject at the completion of the simulation.

**The Next Step**

You have completed this tutorial. If you want to see other examples of turn/mill parts, look in the examples/turnmill directory.
NOTE: You must have FeatureMILL with the FeatureRECOGNITION option or FeatureMILL3D to perform this tutorial.

This tutorial is only available in metric units. The part will be recognized twice, first using the AFR wizard and second using other feature recognition techniques.

In this tutorial you will learn to:

- Import 3D models
- Dynamically shade 3D models
- Create features directly from 3D solid models using both automatic feature recognition and more interactive methods.
Tool Cribs

You must have metric tooling loaded to perform this tutorial. If you do not have metric tools in your database:

1. Exit FeatureCAM by selecting Exit from the File menu.
2. Click on the Start menu. Click on Programs (or All Programs). Select InitDB from the FeatureCAM program group.
3. Click Both and click Next.
4. Answer the questions of the wizard and click Finish at the end.

Importing the CAD Model

1. Start FeatureCAM.
2. Click New File and click Next.
3. Click on Milling Setup, click Millimeter and click Finish.
4. In the Dimensions dialog box, click Finish.
5. Select Import/export options from the File menu. Check Import SAT, SLDPRT, XMT as solids and click OK.
6. Select Import from the File menu.
7. Select files of type ACIS and select Tutor9.sat and click OK.
8. Click on the Part view. Click on the “+” next to the Solids category. Notice that solid1 is listed. This is the solid model you just imported. Click back on the Steps toolbox.

9. Click Isometric from the Principal Views fly-out.

10. Click the Properties button at the bottom of the screen and click OK in the Select Feature dialog box.

11. Click the Resize button.
12. Click Move Geometry and click OK. Click OK again.
13. Select Set tool crib from the Manufacturing menu. Click on the Tools crib and click OK.
Shade the Part

1. Click the Shade button.
2. This shaded view makes it easier to see the cavities in the model. Remember, at this point the part model contains only surfaces.
3. Toggle the Shade button to turn off the shading.

Automatic Feature Recognition

This entire part can be automatically recognized using the automatic feature recognition (AFR) wizard.

1. Click the AFR step from the Steps Toolbar.
2. Click the Next button twice.
3. The features that were just recognized are listed. Click the Finish button.
4. Click the Toolpaths step in the Steps Toolbox. The Simulation toolbar is displayed.
5. Click the 3D simulation button and click Play.
6. Click the Eject button.

Notice that all features of the model were automatically recognized and the part is ready to cut. With many parts automatic feature recognition is all you need to program your part, but with others, you may need to use some of the other feature recognition techniques. For the sake of demonstration you will remove the features you just created and reprogram them using additional feature recognition techniques.

7. Click the Undo button to remove the features you created so far.

Recognize All Holes Using Another Method

1. Select the Features step from the Steps Toolbar.
2. Click Hole and Extract feature from solid model and click Next.
3. Click Recognize and construct multiple holes and click Next.

4. The holes that are automatically recognized are shown on the screen. Three holes were recognized along with the circular pocket in the middle. We want to ignore the center pocket, so select the three other holes with the mouse and click Finish.

5. The three holes have now been recognized.

6. Click the Ordering options button in the Op. list tab.

7. Click on Cut higher operations first, Minimize tool changes and Minimize rapid distance. Click OK.

8. Click the Toolpaths step in the Steps Toolbox. The Simulation toolbar is displayed.

9. Click the 3D simulation button and click Play.

10. Click the Eject button.

**Recognizing All Pockets Automatically**

1. Select the Features step from the Steps Toolbar.
2. Click Pocket and Extract feature from solid model and click Next.
3. Click Automatic recognition and click Next.
4. Click Select all and click Finish.
5. Click the Toolpaths step in the Steps Toolbox. The Simulation toolbar is displayed.
6. Click the 3D simulation button and click Play.
7. Click the Eject button.
Create a Slot Feature Using the Pick Surface Button

1. Select the Features step from the Steps Toolbar.
2. Click Slot and Extract feature from solid model.
3. Click Next.
4. Click the Pick surface button and click on location 1. If the Select dialog box comes up, select face_17 and click OK.
5. Click the Pick surface button again and click on location 2. Select face_14 in the Select dialog box and click OK.
6. Click Next and review the extracted slot dimensions and click Finish.

Create a Side Feature

1. Select Top from the Principal Views fly-out.
2. Drag-select the region shown below.
3. Select Isometric from the Principal Views fly-out.
4. Hold down the SHIFT key and click on the side of the hole pattern that is selected. This will remove the hole pattern from the selected group.
5. Select the Features step from the Steps Toolbar.

6. Click Side and Extract feature from solid model and click Next.

7. Click Select side surfaces and click Next.

8. Click Next.

9. Click the Reverse side button until a blue arrow points to the outside of the part.

10. Click Finish.

**Simulate the Entire Part**

1. Click the Toolpaths step in the Steps Toolbox. The Simulation toolbar is displayed.

2. Click the 3D simulation button and click Play.

3. Click Eject at the completion of the simulation.

**The Next Step**

The features for the entire part have been created directly from the surfaces of the solid model. Using FeatureCAM’s feature-based manufacturing automation, this part can be create quickly and easily.
Chapter 11
Introduction to 3D

NOTE: You must have FeatureMILL3D to perform the examples in this chapter. These examples are only specified in inch units. You must have the basic toolcrib installed.

This example introduces:

- Modeling 3D surfaces
- Manufacturing surfaces using surface milling features
- Manufacturing operations
- Tool selection
- 3D manufacturing attributes

In this example you will model and create manufacturing toolpaths for the following part.
Introduction to 3D Modeling

1. Start FeatureCAM.

2. Click New Part Document button and click Next.

3. Click on Milling Setup, click Inch and click Finish.

4. In the Dimensions dialog box, click Block and set Width to 3, Length to 6.25 and Thickness to 2.0.

5. Click Finish.

6. Select Toolbars from the View menu. On the Toolbars tab, make sure that Geometry is checked and click OK.

7. Click on the lines fly-out menu and select Vertical.

8. Type 1.0 and press the ENTER key. Create lines at 5.25 and 6.0.

9. Click on the lines fly-out and select Horizontal. Create horizontal lines at 0.5, 1.125, and 1.5.

10. Click on the lines fly-out menu and select Pt. Angle. Type 30 as the angle and click at the intersection labeled Pt Angle Location in the figure.

11. Click on the arc fly-out menu and select 2 Pts, Radius. Enter 0.5 as the radius and click on locations 1 and 2.

12. Enter 1.0 as the radius and click at location 3 and 4. Create another arc of radius 1.0 at locations 5 and 6.

13. Select the Curves step from the Steps Toolbox. Select Chain pieces into an open… button. Click at the locations 7 and 8. Click Create.
Create the Bottle Surface

1. Click the Surface step from the Steps Toolbox.
2. Click Surface of revolution and click Next.
3. Click the Pick curve button and select the curve you chained.
4. Click the Pick line button and select the top horizontal line (the one at Y=1.5).
5. Click Finish.
6. Click Isometric from the Principal Views fly-out.
7. Select Hide Geometry from the Hide fly-out.

Introduction to 3D Manufacturing

1. Click on the Select button.
2. Select the surface.
3. Click New Feature button.
4. Select the Surface Milling radio button.
5. Click Next twice.
6. Click Choose rough, semi finish, and finish ... and click Next.
7. Click Z level rough and click Next.
8. Select None and click Next.
9. Select Isoline and click Finish.
Simulating the Entire Part

1. Click the Toolpaths step in the Steps Toolbox. The Simulation toolbar is displayed.

2. Click the 3D simulation button and click Play.

3. Click Eject at the completion of the simulation.

The Next Step

You have completed this tutorial and can move to the next chapter for more advanced 3D manufacturing techniques.
Chapter 12
Advanced 3D Milling

NOTE: You must have FeatureMILL3D to perform this tutorial.

In this example you will import a 3D IGES surface model and create 6 different types of toolpaths for manufacturing the part.

Import the Part

1. Click the New Part Document button.
2. Click Milling Setup, Inch, and click OK.
3. Click Finish in the Dimensions dialog box.
4. Select Import/Export Options from the File menu.
5. Check Center stock automatically and click OK.
6. Select *Import* from the *File* menu.
7. Select *IGES* as *Files of type*.
8. Select *phone.igs* from c:\Program Files\FeatureCAM\examples\3D.

**Create the 3D Strategy**

1. Click on the *Isometric* button from the *Principal views* fly-out.
2. Select *Select all* from the *Edit* menu.
3. Select the *Features* step from the *Steps Toolbar*.
4. Click *Surface Milling* and click *Next* twice.
5. Click *Choose rough, semi finish, and finish ...* and click *Next*.
6. Click *Z level rough* and *3D Boss*.
7. Check *Flat surface support* and click *Next*.
8. Select *Z Semi* and click *Next*.
9. Select *Horizontal + Vertical* and click *Finish*.

**Simulating the Toolpaths**

1. Click the *Toolpaths* step in the *Steps Toolbox*. The Simulation toolbar is displayed.
2. Click the *Centerline simulation* button and click *Play*.
3. Click the *Erase* button to temporarily clear the screen.
4. Click on the different operations in the *Operations List* to see the different toolpaths.
Clean Up the Fillets

1. Click on srf-mill1 in the tree view and click the Strategy tab.

2. Click the Add new operation button. Click Pencil and click Next.

3. Click the Finish radio button and click the Finish button at the bottom of the dialog box.

4. Click the Preview toolpaths button in the Operations List portion of the Manufacturing Results window. The dialog box will warp. Click the Play icon.
selected button in the simulation toolbar. A single toolpath is created along the fillet. Note that this operation takes some time to calculate. Click the Stop button.

The Next Step

You have completed this tutorial.
Note: You must have the Advanced Modeling Option to perform this tutorial.

This tutorial introduces you to the solid modeling capabilities of FeatureCAM by creating a model of the simple computer speaker shown below. The tutorial is available only in metric units and introduces you to:

- Extrude design features
- Hidden line graphics
- Loft design features
- Filleting solid models
- Core/cavity separation of a solid model
- Creating manufacturing features from solids

Getting Started

1. Click New Part Document button.
2. Click on Milling Setup, click Millimeter and click OK.
3. If the stock dialog box is displayed, click OK.
4. Turn on the necessary toolbars by selecting Toolbars from the View menu. Check the Steps, Display Mode and Solid checkboxes on the Toolbars tab and click OK.
Create the Initial Solid

1. Click on the Curves step and click on the Curve wizard step from the Steps toolbar.
2. Select Other methods as the method and Rectangle as the constructor. Click Next.
3. Click the Use corner, width and height radio button and enter 0.0 and 0.0 for the X and Y Corner coordinates.
4. Set Width to 100 and Height to 65. Check Create as arcs and lines and click Finish.
5. Click on the vertical line on the right and click the Delete button.
6. Select Snapping modes from the Options menu. Make sure the End points button is depressed and click OK.
7. Select the Geometry step from the Steps toolbar. Click the Arc from 2 Pts, Radius button.
8. Enter a Radius of 105 and click on the two open end points.
10. Select Chain into a closed boundary and click on the arc you just created. Click the Create button at the bottom of the screen.
11. Click the Solid Wizard button from the Advanced toolbar.
12. Click Define a custom shape and click Next.
13. Select From curves as the method and Extrude as the constructor and click Next.
14. Enter –50 as the Vector Z coordinate and –5 as the Draft Angle and click Finish.
15. Click on the Part view on the left side of the screen. The Solid category now has a “+” next to it. Click on the “+” to reveal the solid, called solid4. That is the name of the solid we are creating. Note the number following the solid name may be different for you.
16. Click on the “+” next to solid4. This reveals the design features that make up the solid. So far, there is only one feature called extbase1. A base feature is the initial feature for a solid.
Hidden Line Graphics

With solids there are additional graphics options available. By default, you are in line drawing mode. With solids, hidden line graphics are available.

1. Select Hide stock from the Hide fly-out in the Advanced toolbar.
2. The default view of your solid model is shown in the top figure. In this figure it is impossible to tell if there is a top on the solid.
3. Click the Hidden Line button. It is located in the Display toolbar. The graphics shown in the bottom figure are displayed. In this figure it is clear that there is a top on the solid.
4. While hidden line mode provides nice graphics, it is considerably slower than simple line drawings and sometimes hides portions of the model you need to pick, so click the Hidden Line button again to toggle the line drawing mode.

Note that hidden line graphics are only available for solids.

Create the Curved Front Surface

1. Select Show stock from the Show fly-out in the Advanced toolbar.
2. Double-click on the stock and click the Resize... button.
3. Click Move geometry and click OK. The stock has now been resized to fit the solid.
4. Select the Front button from the Principal Views flyout.
5. Select the Geometry step from the Steps toolbar. Click the Arc from 2 Pts, Radius button.
6. Set the Radius to 400. Set X1 to 120, Y1 to 0 and Z1 to –20. Set X2 to –10, Y2 to 0 and Z2 to –40, and click the Create button.
7. Create a second arc by entering 160 as the Radius and clicking on the right and left endpoints of the first arc. If your arc curves up instead of down, click on the arc and click the Options button at the bottom of the screen.
8. Select the top arc (the one you created first) and click the Transform button.
9. Click Translate and the Copy button. Enter 70 in Y coordinate of XYZ distance and click OK.
10. Select the bottom arc and click the Transform button.

11. Click Translate and the Move button and transform it 35 in the Y direction and click OK.

12. Select Isometric from the Principal views fly-out.

13. Click the Solid Wizard button from the Advanced toolbar.

14. Select From curves as the method and Loft as the constructor and click Next.

15. Since we want to use this design feature to remove material, click the As Cut radio box and click the pick curve button.

16. Select the arcs in the order shown below and click Finish.

17. The curves are used to create a lofted surface and then the surface is used to cut the solid. Note that an additional design feature, called loftcut1 is now listed in the part view.

Create Constant and Variable Radius Fillets

1. Click the Solid Wizard button from the Advanced toolbar.

2. Select Shape modifiers as the method and Fillet Edges as the constructor and click Next.

3. Enter 5 as the Radius, click the Pick curve button and pick the edges 1-4 shown in the figure.

4. Click Variable and enter 5 as the Begin radius and 10 as the End radius and pick the edges 5-8 in the figure. This will create a variable radius fillet on these edges. As you click each edge an arrow is displayed to show the edge direction. The first radius will be applied to the tail of the arrow and the second to the head of the arrow.

5. Click Finish. Note that the selected edges are filleted and the surrounding surfaces have been trimmed. The corners where the fillets meet are automatically filleted.
Add Thickness

1. Click the Solid Wizard button from the Advanced toolbar.
2. Select Shape modifiers as the method and Shell as the constructor and click Next.
3. Enter an Offset distance of 2 and click the Pick surface button.
4. Click on the top surface as shown in the figure. This surface will not be offset.
5. Click Finish.
6. All faces of the solid except the top surface are now offset by 2 mm to provide thickness to the part. Use hidden line graphics to display the graphics shown on the right.

At this point, the solid model of the speaker is complete.

Create a Mold Cavity

Now the challenge is to create a mold from the solid model. For parts that can be created with two mold halves, FeatureCAM’s core/cavity feature is a useful tool.

1. Click the Solid Wizard button from the Advanced toolbar.
2. Select Manufacturing as the method and Select Core/Cavity as the constructor and click Next.
3. Click the Bottom radio button.
4. Click the Make solid from result. This will create a new solid that contains the cavity faces.
5. Enter cavity as the Name of the new solid.
6. Click Finish. Note that a new solid, called sheet1, is listed in the part view.
Rough the Mold

1. Select *Hide all* from the Hide fly-out menu.

2. Right-click on the *sheet1* solid in the part view and select *Show selected*.

3. Click the *Features* button from the step toolbar.

4. Click the *Surface milling* radio button and click *Next*.

5. The solid has a cap on it that we want to exclude from the feature.
   Click on the last face in the list and click the *Delete* button.

6. Click *Next*.

7. Click *Choose a single operation* and click *Next*.

8. Click *Z level* and click *Next*.

9. Click *Rough* and click *Finish*.

10. Click the *Toolpaths* button in the Steps toolbar.

11. Click *Isometric* from the Principal views fly-out.

12. Click the *Toolpaths* button from the Steps toolbar to display the simulation toolbar.

13. Click the *3D simulation* button and then the play button.

The Next Step

You have completed this tutorial.
NOTE: You must license FeatureWIRE to perform this tutorial.

In this tutorial you will learn the basics of creating wire EDM toolpaths using FeatureWIRE. Specifically you will learn how to:

- Set up your material and wire thickness.
- Create wire EDM features.
- Specify a wire EDM cutting strategy.
- Simulate wire EDM toolpaths.

Getting Started

1. Begin FeatureCAM by selecting FeatureCAM from the Start menu.
2. Select New file and click Next.
3. Click on Wire EDM setup, click Inch and Finish.
4. Set the stock Width and Length to 4.0 and the thickness to 0.5 and click Next.
5. On the Condition page accept all of the default values and click Finish.

Creating the Profile

1. Click the Curve Step from the Steps toolbox.
2. Click the Create curves using the Curve wizard button.
3. Click Other methods and click Rectangle and click Next
4. Click Use corner, width and height.
5. Set the corner point to 1,1,0.

6. Set the corner radius to 0.5 and set the Width and Height to 2.0. Click Finish.

Creating a Wire EDM Feature

1. Click the Features step from the Steps toolbox.
2. Click the Die radio button and click Next.
3. Select Curve1 from the drop down list and click Next twice.
4. Enter 0.5 as the Thickness and click Next.
5. Select Retract as the operation and check the Cutoff and Contour checkboxes.
6. Click Finish.

Simulating a Wire EDM Toolpath

1. Click the Toolpaths step. The Simulation toolbar is displayed.

2. Click the 2D simulation button in the Simulation toolbar. Move the speed control slider to the middle so that the simulation is slowed down.

3. Click the Next Operation button. You’ll notice that the Retract operation makes two passes.
4. Click the **Next Operation** button again. The Cutoff operation now takes two passes.

5. Click the **Next Operation** button once more. The final contour operation is now simulated.

**Creating NC code**

1. Click the **NC Code** step in the Steps toolbar.

2. Click the button in the dialog box to generate the NC code.

**Add a Taper Angle**

1. Select the feature in the graphics window and click the **Properties** button.

2. Click the **Constant taper** radio button. Select **Left** as the taper type and enter 10 as the taper angle and click **OK**.

3. Click the **Isometric** view button from the standard toolbar to get a 3-dimensional view.

4. Click the **Toolpaths** step. Click
and click the play button.

The Next Step

You have completed this tutorial.
Chapter 15
FeatureCAM 2004

FeatureCAM 2004 contains a variety of new features listed below.

All FeatureCAM Products

User definable features – Customize FeatureCAM by adding your own features

One button import of a solid model from a running Solidworks program

Create objects from the part library or patterns of these objects from the new feature wizard

Graphically preview your part before opening it

Box zoom now computes a good center point for subsequent dynamic viewing rotations

Snap a point to a toolpath location

Calculate the mass properties of a solid using the *Volume and cg of solids.bas* addin macro

Easily specify if a machine can perform helical interpolation

Custom manufacturing sheets

Toolbar buttons for the part compare options

Insert an optional stops (M01) and mandatory stops (M00) into your part program

Insert arbitrary G-code into your part program

Insert comments into your part program
Macros can be posted at the beginning of an NC file

Probing support

New simulation and graphics options

- Wireframe graphics are now displayed along with shaded surface/solids
- Optional display of isolines inside of surface boundaries
- Improvements in shaded selection – It is now easier to select surfaces in shaded mode. The closest surface is now always selected
- Display single Z level of a Z level rough or Z level finish operation
- Display intermediate simulation results for centerline and solid simulations without recalculation
- Ramps and leads are now displayed in a different color than the rest of the toolpath moves

**FeatureMILL**

Tool life management

Wrapped features with walls perpendicular to the axis

User definable milling tool holders

Control the starting height of zig-zag/helical ramping move with the new Z ramp clearance attribute

Helical boring

Automatic tool holder selection

Thin walled milling
FeatureMILL3D

- New 3D interface wizard
- Flat surface Z rough slicing
- No recalculation of 3D toolpaths if lead or ramping values change
- Vastly improved Z rough – Z rough has been rewritten to avoid any missing slices or slices with bad orientations
- Improved Z-semi finish pass – Z semi-finish also benefited from the Z rough changes
- Automatic boundary curves are 2 times faster

FeatureWIRE

- 4 axis arcs in FeatureWIRE – Wire EDM posts can now be configured to output 4axis arcs
- Mathematics in wire EDM posts

FeatureRECOGNITION

- Automatic feature recognition
- Associative feature recognition - Rerecognition of features from an altered solid model
- Automatic hole recognition of holes around an index axis (or a turn/mill axis)
- Auto side recognition from new feature wizard
- Auto boss recognition from new feature wizard

FeatureTURN

- Special turning toolpaths for ISCAR CUT-GRIP® tooling
Five Axis Positioning

5-axis rotation limits (use 0 to –180 for first axis rotation)

FeatureTURN/MILL

Easily position features with arbitrary B-axis orientations
Index

2
2D simulation, 10

3
3D milling, 77
Pencil milling, 79
3D simulation, 10
3D solid simulation, 10
3D milling roughing, 78

A
Advanced toolbar, 22
Arcs fly-out, 24

B
Bolt hole patterns, 43

C
Cavity, 86
Centerline simulation, 10
Chaining, 39
Circles, 37
Circles fly-out, 24
Core, 86
Curve wizard, 22
Curves step, 7, 8

D
Default attributes, 14
Design
Solids, 81
Surface, 75
Dimensions fly-out, 24
Display mode toolbar, 28
Dongle, 1

E
Engraving, 63
Evaluating FeatureCAM, 5

F
Feature recognition, 65
FeatureCAM product line, 1
FeatureRECOGNITION, 65
Features
2.5D milling, 29
2.5D milling from curves, 37
3D Milling, 77
Editing, 34
Recognizing, 65
Turn/mill, 62
Turned, 49
Features step, 7, 9
FeatureTURN, 47, 55
FeatureTurn/Mill, 61
Feed optimization, 12
Fillets, 84
Fly-out toolbars, 19

G
Geometry step, 7, 8
Geometry toolbar, 24
Graphics window, 19
Grooves
OD Turned, 51
Turned face, 63

H
Help
Context sensitive, 16
On-line, 15
Hidden line, 27
Hide fly-out menu, 22
Holes
Bolt hole pattern, 43
<table>
<thead>
<tr>
<th>Index</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Recognizing, 67</td>
<td></td>
</tr>
<tr>
<td>Turn/mill, 62</td>
<td></td>
</tr>
<tr>
<td><strong>I</strong></td>
<td></td>
</tr>
<tr>
<td>IGES import, 77</td>
<td></td>
</tr>
<tr>
<td>Import</td>
<td></td>
</tr>
<tr>
<td>IGES, 77</td>
<td></td>
</tr>
<tr>
<td>SAT, 66</td>
<td></td>
</tr>
<tr>
<td>Solid, 66</td>
<td></td>
</tr>
<tr>
<td>Installation, 2</td>
<td></td>
</tr>
<tr>
<td><strong>L</strong></td>
<td></td>
</tr>
<tr>
<td>Lines, 38</td>
<td></td>
</tr>
<tr>
<td>Lines fly-out, 24</td>
<td></td>
</tr>
<tr>
<td>Live tooling, 61</td>
<td></td>
</tr>
<tr>
<td><strong>M</strong></td>
<td></td>
</tr>
<tr>
<td>Manufacturing preferences, 14</td>
<td></td>
</tr>
<tr>
<td>Manufacturing results window, 19</td>
<td></td>
</tr>
<tr>
<td>Molds, 86</td>
<td></td>
</tr>
<tr>
<td><strong>N</strong></td>
<td></td>
</tr>
<tr>
<td>NC code</td>
<td></td>
</tr>
<tr>
<td>Generating, 34</td>
<td></td>
</tr>
<tr>
<td>Saving, 36</td>
<td></td>
</tr>
<tr>
<td>NC code step, 7, 12</td>
<td></td>
</tr>
<tr>
<td><strong>O</strong></td>
<td></td>
</tr>
<tr>
<td>Optimize feedrates, 12</td>
<td></td>
</tr>
<tr>
<td><strong>P</strong></td>
<td></td>
</tr>
<tr>
<td>Part view toolbox, 17, 20</td>
<td></td>
</tr>
<tr>
<td>Patterns, 43</td>
<td></td>
</tr>
<tr>
<td>Pencil milling, 79</td>
<td></td>
</tr>
<tr>
<td>Plunge point, 40</td>
<td></td>
</tr>
<tr>
<td>Pockets</td>
<td></td>
</tr>
<tr>
<td>Recognizing, 69</td>
<td></td>
</tr>
<tr>
<td>Post processor</td>
<td></td>
</tr>
<tr>
<td>Editing, 14</td>
<td></td>
</tr>
<tr>
<td>Selecting, 35</td>
<td></td>
</tr>
<tr>
<td><strong>R</strong></td>
<td></td>
</tr>
<tr>
<td>Region of interest, 10</td>
<td></td>
</tr>
<tr>
<td><strong>S</strong></td>
<td></td>
</tr>
<tr>
<td>SAT import, 66</td>
<td></td>
</tr>
<tr>
<td>Saving NC code, 36</td>
<td></td>
</tr>
<tr>
<td>Security key, 1</td>
<td></td>
</tr>
<tr>
<td>Selecting Graphical Objects, 21</td>
<td></td>
</tr>
<tr>
<td>Setups button, 23</td>
<td></td>
</tr>
<tr>
<td>Shading, 27</td>
<td></td>
</tr>
<tr>
<td>Show fly-out menu, 22</td>
<td></td>
</tr>
<tr>
<td>Simulation Toolbar, 10</td>
<td></td>
</tr>
<tr>
<td>Snap feedback, 24</td>
<td></td>
</tr>
<tr>
<td>Snap mode toolbars, 23</td>
<td></td>
</tr>
<tr>
<td>Snap modes, 22, 23</td>
<td></td>
</tr>
<tr>
<td>Solid, 66</td>
<td></td>
</tr>
<tr>
<td>Standard toolbar, 18</td>
<td></td>
</tr>
<tr>
<td>Steps, 7</td>
<td></td>
</tr>
<tr>
<td>Curves, 7, 8</td>
<td></td>
</tr>
<tr>
<td>Features, 7, 9</td>
<td></td>
</tr>
<tr>
<td>Geometry, 7, 8</td>
<td></td>
</tr>
<tr>
<td>NC code, 7, 12</td>
<td></td>
</tr>
<tr>
<td>Stock, 7, 8</td>
<td></td>
</tr>
<tr>
<td>Toolpaths, 7, 10</td>
<td></td>
</tr>
<tr>
<td>Steps toolbar, 25</td>
<td></td>
</tr>
<tr>
<td>Stock step, 7, 8</td>
<td></td>
</tr>
<tr>
<td>Subspindle, 59</td>
<td></td>
</tr>
<tr>
<td>Surface modeling, 75</td>
<td></td>
</tr>
<tr>
<td>Surface wizard, 22</td>
<td></td>
</tr>
<tr>
<td><strong>T</strong></td>
<td></td>
</tr>
<tr>
<td>Text, 63</td>
<td></td>
</tr>
<tr>
<td>Threads, 51</td>
<td></td>
</tr>
<tr>
<td>Tool load, 10</td>
<td></td>
</tr>
<tr>
<td>Tool mapping, 12, 35</td>
<td></td>
</tr>
<tr>
<td>Tool numbers, 12</td>
<td></td>
</tr>
<tr>
<td>Tool pockets, 12</td>
<td></td>
</tr>
<tr>
<td>Tool slots, 12</td>
<td></td>
</tr>
<tr>
<td>Toolbars</td>
<td></td>
</tr>
<tr>
<td>Advanced, 22</td>
<td></td>
</tr>
<tr>
<td>Customizing, 26</td>
<td></td>
</tr>
<tr>
<td>Display mode, 28</td>
<td></td>
</tr>
<tr>
<td>Fly-out, 19</td>
<td></td>
</tr>
<tr>
<td>Geometry, 24</td>
<td></td>
</tr>
<tr>
<td>Simulation, 10</td>
<td></td>
</tr>
</tbody>
</table>
Snap mode, 23
Standard, 18
Steps, 25
Tooling
  Changing, 57
Toolpaths step, 7, 10
Tools
  Selecting, 46
Trademark information, iv
Transform, 18
Trial versions, 5
Turn/mill, 61
Turning, 47, 55

U
Undo, 18

V
Variable radius fillets, 84

W
Window
  Graphics, 19
  Manufacturing results, 19
Wizards
  Curve, 22
  Solid, 22
  Surface, 22